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About This Guide

This Novell GroupWise Server Migration Utility Installation and Migration Guide explains how to use the 
GroupWise Server Migration Utility to migrate a GroupWise 7 or GroupWise 8 system from NetWare 
or Linux or Windows. 

IMPORTANT: GroupWise 2012 does not support NetWare, so earlier GroupWise components must 
be moved from NetWare to Linux or Windows.

The guide is divided into the following sections: 

 Part I, “Server Migration Utility,” on page 9
 Chapter 1, “What Is the Server Migration Utility?,” on page 11
 Chapter 2, “System Requirements,” on page 17
 Chapter 3, “Installing the Server Migration Utility,” on page 19
 Chapter 4, “Planning Your GroupWise Server Migration,” on page 21
 Chapter 5, “Meeting Migration Prerequisites,” on page 33
 Chapter 6, “Running the Server Migration Utility,” on page 37
 Chapter 7, “Migrating a Post Office and Its POA to Linux,” on page 41
 Chapter 8, “Migrating a Domain and Its Agents to Linux,” on page 53
 Chapter 9, “What’s Next,” on page 67

 Part II, “Manual Server Migration,” on page 69
 Chapter 10, “Transitioning GroupWise Administration to Linux,” on page 71
 Chapter 11, “Manually Migrating a Post Office and Its POA to Linux,” on page 75
 Chapter 12, “Manually Migrating a Domain and Its MTA to Linux,” on page 85
 Chapter 13, “Manually Migrating the Internet Agent to Linux,” on page 91
 Chapter 14, “Manually Migrating WebAccess to Linux,” on page 95
 Chapter 15, “Manually Migrating Monitor to Linux,” on page 101

 Part III, “In-Place Database Migration,” on page 105
 Chapter 16, “Performing an In-Place Database Migration,” on page 107

 Part IV, “Appendixes,” on page 109
 Appendix A, “Troubleshooting Post-Migration Problems,” on page 111
 Appendix B, “Documentation Updates,” on page 115

Audience

This guide is intended for network administrators who want to move their GroupWise systems from 
NetWare or Linux or Windows. 
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Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comment feature at the bottom of each page of the 
online documentation.

Additional Documentation

The GroupWise Server Migration Utility can be used with the following versions of GroupWise:

 GroupWise 2012: GroupWise 2012 Documentation Web site (http://www.novell.com/
documentation/groupwise2012)

 GroupWise 8: GroupWise 8 Documentation Web site (http://www.novell.com/documentation/
gw8)

 GroupWise 7: Novell GroupWise 7 Documentation Web site (http://www.novell.com/
documentation/gw7)

The following guides are available for each supported GroupWise version:

 Installation Guide
 Server Migration Guide
 Administration Guide
 Multi-System Administration Guide 
 Interoperability Guide
 Troubleshooting Guides
 GroupWise User Frequently Asked Questions (FAQ)
 GroupWise User Guides
 GroupWise User Quick Starts
8 GroupWise Server Migration Guide
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 Chapter 1, “What Is the Server Migration Utility?,” on page 11
 Chapter 2, “System Requirements,” on page 17
 Chapter 3, “Installing the Server Migration Utility,” on page 19
 Chapter 4, “Planning Your GroupWise Server Migration,” on page 21
 Chapter 5, “Meeting Migration Prerequisites,” on page 33
 Chapter 6, “Running the Server Migration Utility,” on page 37
 Chapter 7, “Migrating a Post Office and Its POA to Linux,” on page 41
 Chapter 8, “Migrating a Domain and Its Agents to Linux,” on page 53
 Chapter 9, “What’s Next,” on page 67

IMPORTANT: For information about converting a domain or post office for use with the GroupWise 
Linux agents without migrating it to a different physical server, see Part III, “In-Place Database 
Migration,” on page 105.
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1 1What Is the Server Migration Utility?

The GroupWise Server Migration Utility is a tool to help you move GroupWise components (post 
offices, domains, and agents) from NetWare or Windows servers to Linux servers. 

IMPORTANT: If you have a domain or post office that is located on a SAN, and it has been serviced 
by the GroupWise NetWare or Windows agents in the past, you can convert the domain or post office 
for use with the GroupWise Linux agents without moving. For instructions, see Part III, “In-Place 
Database Migration,” on page 105.

The Server Migration Utility prompts you for information so it can set up the connection between the 
source NetWare or Windows server where a GroupWise component is located and the destination 
Linux server where you want to migrate that GroupWise component. The utility then creates the 
connection, transfers the GroupWise data, and installs and starts the Linux GroupWise agent or 
agents for the component. Users can still use their client of choice (Windows, Macintosh, or Linux) to 
access their mailboxes, regardless of whether the mailboxes reside on Linux, NetWare, or Windows 
servers. 

If you want to understand what happens “behind the scenes,” continue reading this section. If you 
just want to install and run the utility, skip this section and continue with Chapter 2, “System 
Requirements,” on page 17, Chapter 3, “Installing the Server Migration Utility,” on page 19, and 
Chapter 4, “Planning Your GroupWise Server Migration,” on page 21. You can return to this “behind 
the scenes” information during the migration procedure if you want.

 Section 1.1, “Mount Commands,” on page 11
 Section 1.2, “Software Management,” on page 12
 Section 1.3, “Post Office Migration Process,” on page 12
 Section 1.4, “Domain Migration Process,” on page 14

IMPORTANT: The Server Migration Utility moves GroupWise components from one server to 
another. It does not move GroupWise components to a different GroupWise system, a different 
eDirectory tree, or a different version of GroupWise software. 

The Server Migration Utility is not cluster aware. You can use it to move data to a Linux server that is 
part of a cluster, but the utility is not aware of the other nodes in the cluster.

1.1 Mount Commands
When you migrate a post office or a domain, the Server Migration Utility prompts you for some basic 
system information about the source and destination servers, then sets up the connection between 
your NetWare or Windows server and your Linux server. From the system information you provide, 
the utility constructs the appropriate mount commands:

NetWare: ncpmount -m -A server_address -S server_name -V volume 
                    -U full_user_ID -P password /mount_point
What Is the Server Migration Utility? 11



The Server Migration Utility also handles establishing a connection with the ssh (secure shell) 
daemon on Linux. This connection enables the Server Migration Utility to log in to the destination 
Linux server as root and execute programs there.

1.2 Software Management
During the migration, the Server Migration Utility needs access to a GroupWise DVD, software 
image, or downloaded image for GroupWise 7, 8, or 2012 for Linux. You must use the media for the 
version of GroupWise that is already installed on your system. You cannot update to a new version of 
GroupWise as you migrate from one platform to another. 

IMPORTANT: If you are planning on updating as part of the migration, you should update your 
existing system first, if it is on an operating system supported by the newer version, then perform the 
migration. If you are currently running a version of GroupWise earlier than GroupWise 7, you must 
update before you can run the Server Migration Utility. 

If your GroupWise system is currently on NetWare and you are updating to GroupWise 2012, you 
must migrate to Linux or Windows first, then update to GroupWise 2012, because NetWare is not 
supported for GroupWise 2012.

The Server Migration Utility copies a number of GroupWise agent and utility RPMs (Linux 
installation programs) to the destination Linux server. The RPMs are stored in a temporary location 
of your choosing and can be deleted by the utility after the migration is completed.

The Server Migration Utility uses the ssh connection to the Linux server to run the RPMs on the 
Linux server as if it were the root user. All aspects of GroupWise installation and administration 
require root user permissions.

1.3 Post Office Migration Process
A post office migration is carried out in two stages to minimize downtime for GroupWise users. 
During the first stage, the Server Migration Utility performs the following tasks:

 Mounts the source NetWare or Windows server as a file system to the destination Linux server
 Creates a connection to the ssh daemon on the destination Linux server
 Creates the directory structure necessary for the GroupWise software and the post office
 Copies GroupWise utility software to the Linux server and installs it
 Copies the GroupWise Linux POA software to the Linux server
 Copies the post office data to the Linux server by using the GroupWise Database Copy utility 

(DBCopy), which prevents post office files from being modified during the copy operation, 
using the same locking mechanism used by other GroupWise programs that access databases

 Copies certificate files and key files if SSL is in use
 Identifies remote document storage areas associated with libraries in the post office

Windows: smbmount //server_name/share_name /mount_point 
                    -o username=user_id,password=password

cifs.mount //server_name/share_name /mount_point 
                    -o username=user_id,password=password
12 GroupWise Server Migration Guide



 Installs, configures, and starts the POA on the Linux server
 Cleans up its temporary files, such as the utility software used during the migration process

After the first stage, you perform some testing of the migrated post office by:

 Logging in to a mailbox in the migrated post office
 Verifying the contents of the migrated mailbox

The Server Migration Utility then stops the Linux POA in preparation for the second stage of the post 
office migration. You also have some manual steps to perform in preparation for the second stage:

 In ConsoleOne, you reconfigure the Post Office object and the POA object for their new locations 
on the Linux server.

 If the post office has remote document storage areas, you provide their new locations on Linux.
 You specify the new IP address for the POA on the Linux server.
 At the POA Web console on the source server, you verify that the changes to the GroupWise 

objects have replicated to the domain.
 At the source server, you stop the original POA.

During the second stage, the Server Migration Utility performs the following tasks:

 Copies all post office data that has been modified since the first stage of the migration
 Verifies that all files and directories that have been copied to Linux are in lowercase, and if they 

are not, renames them to lowercase
 Performs an operation equivalent to GroupWise Check (GWCheck) with the storelowercase 

option to ensure that all file names and directory names stored in the guardian database 
(ngwguard.db) are also converted to lowercase.

 Copies the contents of the message queue directories so that no incoming or outgoing messages 
are lost

 Deletes the temporary copy of the GroupWise Linux software that was used to install the Linux 
POA.

 Unmounts the source server from the Linux server.

After the post office migration is complete, you have two more manual steps to perform:

 At the Linux server, you configure the Linux POA to run as a non-root user, which is a 
preferable configuration for security reasons.

 Finally, you start the Linux POA for the migrated post office.

Step-by-step instructions for each part of this process are found in Chapter 7, “Migrating a Post 
Office and Its POA to Linux,” on page 41.

If the Server Migration Utility is unable to migrate a post office, you can perform the steps yourself, 
as described in Chapter 11, “Manually Migrating a Post Office and Its POA to Linux,” on page 75.
What Is the Server Migration Utility? 13

http://www.novell.com/documentation/gw7/pdfdoc/gw7_tsh3/gw7_tsh3.pdf#A3edzdk


1.4 Domain Migration Process
A domain migration is carried out in a single stage. Users are not directly affected when the MTA is 
down, and the volume of data to migrate is typically smaller for a domain that for a post office. 
Therefore, the migration goes more quickly.

The Server Migration Utility performs the following preparatory tasks:

 Mounts the source NetWare or Windows server as a file system to the destination Linux server
 Creates a connection to the SSH daemon on the destination Linux server
 Creates the directory structure necessary for the GroupWise software and the domain
 Copies GroupWise utility software to the Linux server and installs it
 Copies the GroupWise Linux agent software to the Linux server
 Copies the domain data to the Linux server by using the GroupWise Database Copy utility 

(DBCopy)
 Copies certificate files and key files if SSL is in use
 For the GWIA, ensures that no port conflict with Postfix can occur

Before the domain migration starts, you have some manual steps to perform in preparation for the 
domain migration:

 In ConsoleOne, you reconfigure the Domain object and the MTA object for their new locations 
on the Linux server.

 If you are migrating additional agents, you do the same for them.
 You specify the new IP address for the MTA on the Linux server.
 If you are migrating additional agents, you do the same for them.
 In the Link Configuration utility in ConsoleOne, you verify that the changes to the Domain 

object have replicated to other domains.
 At the source server, you stop the original MTA and additional agents to migrate as needed.

Then the Server Migration Utility performs the migration tasks:

 Copies the MTA local working directory (mslocal) if it is located within the domain directory 
structure or if it is specified in the MTA startup file by using the /work switch.

 Copies agent subdirectories to the Linux server, such as those used by the GWIA 
(\domain\wpgate\gwia) and WebAccess Agent (\domain\wpgate\webac70a or 
\domain\wpgate\webac80a)

 Installs the agent software on the Linux server but does not start any agents
 Cleans up its temporary files, such as the utility software used during the migration process

After the domain migration is complete, you have a few more manual steps to perform:

 At the Linux server, you configure the Linux agents to run as a non-root user, which is a 
preferable configuration for security reasons.

 You start the Linux MTA for the migrated domain, and start the GWIA and WebAccess Agent if 
they were also migrated.

NOTE: The WebAccess Agent is not part of GroupWise 2012, but is part of earlier GroupWise 
versions.
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Step-by-step instructions for each part of this process are found in Chapter 8, “Migrating a Domain 
and Its Agents to Linux,” on page 53.

If the Server Migration Utility is unable to migrate a domain, you can perform the steps yourself, as 
described in Chapter 12, “Manually Migrating a Domain and Its MTA to Linux,” on page 85.
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2 2System Requirements

 Section 2.1, “GroupWise Version Requirements,” on page 17
 Section 2.2, “Server Operating System Requirements,” on page 17
 Section 2.3, “Windows Workstation Requirements,” on page 18

2.1 GroupWise Version Requirements
 GroupWise 2012 for Linux

or

 GroupWise 8 for Linux

or

 GroupWise 7 for Linux

IMPORTANT: You cannot update the version of your GroupWise software as part of the migration 
to Linux. You must use the same version of GroupWise that is already in use in source post offices 
and domains. 

If you are planning to update your GroupWise system on an operating system supported by the 
newer version of GroupWise, update source post offices and domains first, then migrate the updated 
GroupWise post offices and domains to Linux. This enables you to test your update in a known 
environment.

If your GroupWise system is currently on NetWare and you are updating to GroupWise 2012, you 
must migrate to Linux or Windows first, then update to GroupWise 2012, because GroupWise 2012 
does not support NetWare.

2.2 Server Operating System Requirements
The source server operating system requirements correspond to the supported operating system 
versions for your version of GroupWise.

 GroupWise 2012: “GroupWise System Requirements”

or

 GroupWise 8: “GroupWise System Requirements”

or

 GroupWise 7: “GroupWise System Requirements”
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IMPORTANT: If you are planning on updating your GroupWise system, do not migrate it onto a 
version of Linux that is not supported for the version of GroupWise that you are updating to.

2.3 Windows Workstation Requirements
The workstation where you run the Server Migration Utility has the same requirements as any 
GroupWise administrator workstation:

 Windows XP/Vista/7 or Windows Server 2000/2003/2003 R2/2008/2008 R2

 Novell Client

 ConsoleOne 1.3.6 or later with the GroupWise snap-ins installed

If you are migrating from a Windows server, you can run the Server Migration Utility on the 
Windows server. Just make sure that the requirements for the Novell Client and ConsoleOne are met 
on the Windows server.
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3 3Installing the Server Migration Utility

1 From the Novell Downloads Web site (http://download.novell.com), download the GroupWise 
Server Migration Utility (gwsvrmig1.1.0.exe) into a temporary directory.

2 Run gwsvrmig1.1.0.exe to extract the software into a convenient directory on a Windows 
machine that meets the requirements listed in Section 2.3, “Windows Workstation 
Requirements,” on page 18.
This directory becomes the Server Migration Utility installation directory.

3 Run gwsvrmig.exe to start the Server Migration Utility.
4 Click Help on any page where you need assistance filling in the fields or where you want to 

know what the utility is doing.
5 Continue with Planning Your GroupWise Server Migration.
Installing the Server Migration Utility 19

http://download.novell.com


20 GroupWise Server Migration Guide



4 4Planning Your GroupWise Server 
Migration

When you migrate your GroupWise system from NetWare or Windows servers to Linux servers, the 
Server Migration Utility prompts you for information about your system. The process goes more 
smoothly if you gather the information before you start. You can use the GroupWise Migration 
Worksheet to record the information. You should fill out a worksheet for each source/destination pair 
of servers that you are going to migrate.

 Section 4.1, “Gathering Source Server Information,” on page 21
 Section 4.2, “Gathering Destination Server Information,” on page 22
 Section 4.3, “Gathering Software Information,” on page 23
 Section 4.4, “Gathering GroupWise Component Information,” on page 23
 Section 4.5, “Handling the Potential Internet Agent Port Conflict,” on page 28
 Section 4.6, “Handling SSL Certificate and Key Files,” on page 28
 Section 4.7, “Estimating Migration Time,” on page 29
 Section 4.8, “GroupWise Migration Worksheet,” on page 30

4.1 Gathering Source Server Information
Your network might consist of only NetWare servers, only Windows servers, or a combination of 
both.

The Server Migration Utility needs information about the source NetWare or Windows server in 
order to create a mount command for accessing the source server from the destination Linux server. 
This gives the utility access to the post office or domain directory structure that is copied during the 
migration process.

GROUPWISE MIGRATION WORKSHEET

Under Item 1: Source Platform, mark the source platform for the source/destination server pair.

GROUPWISE MIGRATION WORKSHEET

Under Item 2: Source Server, specify the name of the source server and also its IP address or hostname. If the 
source server has multiple IP addresses, use the IP address that is accessible from the Linux server. 
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The Server Migration Utility needs to log in to the source NetWare or Windows server. It needs to use 
a user that has read/write access to the source server and to the post office or domain directory and 
its contents.

For more information about why the Server Migration Utility needs the source server credentials and 
what the utility does with them, see the following section in the GroupWise Administration Guide for 
your version of GroupWise:

 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

4.2 Gathering Destination Server Information
The Server Migration Utility needs certain information in order to communicate with the ssh (secure 
shell) daemon on the destination Linux server. The ssh daemon allows root access for the utility to 
run the programs required for migration locally on the Linux server.

For more information about why the Server Migration Utility needs the root password and what the 
utility does with it, see the following section in the GroupWise Administration Guide for your version of 
GroupWise:

 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

The first time you attempt to log in to the Linux server, you are asked to verify the RSA key 
fingerprint for the server. 

SSH does not use certificate files, key files, and certificate authorities as is done for SSL encryption. 
Instead, SSH generates a string of numbers that is a special checksum of the server host key. You 
obtain the equivalent string from the server itself by using the following command on the Linux 
server:

ssh-keygen -l -f /etc/ssh/ssh_host_rsa_key.pub

Compare the string you receive from the Linux server with the string presented by the Server 
Migration Utility. If the strings match, you have a secure connection.

In general, it is safe to simply accept the RSA key fingerprint presented by the Server Migration 
Utility. You might decide not to perform the actual comparison.

GROUPWISE MIGRATION WORKSHEET

Under Item 3: Source Server Credentials, specify an appropriate user name and password. For NetWare, 
specify the distinguished user name, which includes the context of the User object in the eDirectory tree (for 
example, admin.users.novell). For Windows, specify a Windows user name.

GROUPWISE MIGRATION WORKSHEET

Under Item 4: Destination Server, specify the IP address or hostname of the destination Linux server.

Under Item 5: Destination Server Credential, specify the root password for the server.
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4.3 Gathering Software Information
You can migrate GroupWise 7, 8, and 2012 components. You must use the version of GroupWise 
software that matches the version of GroupWise that is already installed. You cannot use the Server 
Migration Utility to update domains and post offices from an earlier version of GroupWise during 
the migration process.

The Server Migration Utility needs access to a GroupWise for Linux DVD or software distribution 
directory, such as a Support Pack. The Server Migration Utility then copies the agent and utility 
RPMs (Linux installation programs) that it needs for the migration into a temporary location on the 
Linux server. The default is /tmp/groupwise/software. Having the RPMs on the Linux server 
enables the Server Migration Utility to run the RPMs as root through the ssh connection. After the 
migration is complete, the Server Migration Utility can delete the RPMs to conserve disk space on 
your Linux server. 

NOTE: A GroupWise software distribution directory on a NetWare or Windows server does not 
contain GroupWise Linux software unless you have placed it there from a GroupWise for Linux DVD 
or software distribution directory.

4.4 Gathering GroupWise Component Information
 Section 4.4.1, “Post Offices and Domains,” on page 23
 Section 4.4.2, “Additional Agents for a Domain,” on page 26
 Section 4.4.3, “Remote Document Storage Areas for a Post Office,” on page 27

4.4.1 Post Offices and Domains

 “Auto-Detection” on page 24
 “Default Locations” on page 24
 “Post Office Information” on page 25
 “Domain Information” on page 25

GROUPWISE MIGRATION WORKSHEET

Under Item 6: RSA Key Fingerprint, record the string of letters and numbers that you received from the Linux 
server, if you want to perform the comparison.

GROUPWISE MIGRATION WORKSHEET

Under Item 7: Software Locations, specify the root directory of a GroupWise for Linux DVD or software 
distribution directory, the full path to the location where you want to store RPMs during the migration, and 
whether you want to delete the RPMs after migration.
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Auto-Detection

For NetWare servers, the Server Migration Utility has an Auto-Detect feature that attempts to locate 
post offices and domains on the NetWare server. The Auto-Detect feature scans NCF files in the 
sys:\system directory and looks for load commands for the GroupWise agents (for example, 
gwpoa.nlm and gwmta.nlm). Each agent load command includes the post office directory or the 
domain directory as the setting for the /home switch. The Auto-Detect feature also identifies startup 
files for the POA (post_office.poa) and the MTA (domain.mta). If your NetWare server does not 
have GroupWise NCF files and agent startup files in sys:\system, then the Auto-Detect feature does 
not find any post offices, domains, or agents.

For Windows servers, the Auto-Detect feature is not available. You must manually specify the 
locations of post offices, domains, and agents. Post offices and domains could be located anywhere 
on the Windows server. By default, the Windows agents are installed to:

 GroupWise 2012: c:\Program Files\Novell\GroupWise Server\Agents
 GroupWise 8: c:\Program Files\Novell\GroupWise Server\Agents
 GroupWise 7: c:\grpwise

Default Locations

By default, post offices and domains are migrated to the /var/opt/novell/groupwise/mail 
directory. This is the typical location for mail directories on Linux. You might prefer a shorter path 
name (for example, /gwsystem). Be sure to include the post office directory or domain directory in 
the path (for example, /gwsystem/sales). 

IMPORTANT: To minimize case sensitivity issues on Linux, make sure that domain and post office 
directory names consist of all lowercase letters in NetWare or Windows file systems and in 
ConsoleOne.

The Linux POA and MTA software is always installed to subdirectories of /opt/novell/groupwise/
agents. On Linux, you can choose whether or not you want the agents to run as the root user, as 
described in the following section of the GroupWise Installation Guide for your version of GroupWise: 

 GroupWise 2012: “Running the Linux GroupWise Agents as a Non-root User” in “Installing 
GroupWise Agents”

 GroupWise 8: “Running the Linux GroupWise Agents As a Non-root User” in “Installing 
GroupWise Agents”

 GroupWise 7: “Running the Linux GroupWise Agents as a Non-root User” in “Installing 
GroupWise Agents”

Running as a non-root user is strongly preferred for security reasons.
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Post Office Information

If you are migrating a post office:

To find out what changes the Server Migration Utility makes to the POA startup file when it migrates 
it to Linux, see the following section of the GroupWise Administration Guide for your version of 
GroupWise:

 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

Domain Information

If you are migrating a domain, you also need to consider the MTA working directory (mslocal). By 
default, it is located under the domain directory, but it can be placed elsewhere by using the /work 
switch in the MTA startup file. The Server Migration Utility can copy the mslocal directory for you if 
it is under the domain directory, on the same NetWare volume, or on the same Windows server as the 
domain directory. In all cases, it is placed under the domain directory on the Linux server.

If the mslocal directory is located on a different NetWare volume or on a different server, the Server 
Migration Utility cannot copy it for you. You must copy it manually to the Linux server, as described 
in Section 8.9, “Manually Migrating the MTA Working Directory,” on page 64. You can do this after 
you have migrated the domain.

If you are migrating a domain:

To find out what changes the Server Migration Utility makes to the MTA startup file when it migrates 
it to Linux, see the following section in the GroupWise Administration Guide for your version of 
GroupWise:

 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

GROUPWISE MIGRATION WORKSHEET

Under Item 8: Post Office Information, specify the directory where the post office database (wphost.db) is 
located, the full path to the POA startup file, the full path to where you want to migrate the post office (the post 
office directory), and whether you want the POA to run as root.

If you have more than one POA for the post office, migrate the main one first. Additional POAs must be installed 
and configured manually.

GROUPWISE MIGRATION WORKSHEET

Under Item 9: Domain Information, specify the directory where the domain database (wpdomain.db) is 
located, the full path to the MTA startup file, the full path to where you want to migrate the domain (the domain 
directory), the full path to the MTA working directory, and whether you want the MTA to run as root.
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4.4.2 Additional Agents for a Domain

The Internet Agent (GWIA) and the WebAccess Agent startup files must be identified manually if 
you want the settings in the startup files to be migrated.

 “Internet Agent” on page 26
 “WebAccess Agent” on page 26

NOTE: The WebAccess Agent is not part of GroupWise 2012, but is part of earlier GroupWise 
versions.

Internet Agent

The GWIA startup file is gwia.cfg. The default location of the startup file varies by platform:

To find out what changes the Server Migration Utility makes to the GWIA startup file when it 
migrates it to Linux, see the following section in the GroupWise Administration Guide for your version 
of GroupWise:

 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

WebAccess Agent

The WebAccess Agent startup file is webacnna.waa The default location of the startup file varies by 
platform:

NOTE: The WebAccess Agent is not part of GroupWise 2012, but is part of earlier GroupWise 
versions.

NetWare: sys:\system\gwia.cfg

Windows: \domain\wpgate\gwia\gwia.cfg

GROUPWISE MIGRATION WORKSHEET

Under Item 10: Internet Agent Information, specify the full path to the GWIA startup file and whether you want 
the GWIA to run as root.

NetWare: GroupWise 2012: N/A

GroupWise 8: sys:\system\webac80a.waa

GroupWise 7: sys:\system\webac70a.waa

Windows: GroupWise 2012: N/A

GroupWise 8: c:\Program Files\Novell\GroupWise Server\

WebAccess\webac80a.waa

GroupWise 7: c:\webacc\webac70a.waa
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To find out what changes the Server Migration Utility makes to the WebAccess Agent startup file 
when it migrates it to Linux, see the following section in the GroupWise Administration Guide for your 
version of GroupWise:

 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

The Server Migration Utility migrates the WebAccess Agent but not the WebAccess Application that 
is installed to your Web server. If you want to use a Linux Web server with WebAccess, you can 
follow the instructions in Section 14.2, “Manually Migrating the WebAccess and WebPublisher 
Applications to Linux,” on page 98 after you have migrated the WebAccess Agent.

4.4.3 Remote Document Storage Areas for a Post Office

The post office that you want to migrate might own libraries with remote document storage areas. A 
remote document storage area is a storage area that resides outside of the post office directory 
structure, rather than within it. A remote document storage area might be on the same server with 
the post office, or it might be on a different server. The Server Migration Utility currently cannot 
migrate remote document storage areas for you.

The utility can list all the remote document storage areas associated with a post office and can 
provide their current locations. You need to decide where you want the document storage areas to 
reside after the post office has been migrated. You must move them to the same Linux server as the 
post office, because document storage areas are not supported on remote Linux servers.

If it is necessary to keep your documents in a location other than Linux, you should create a new post 
office just for document storage areas and transfer your current document storage areas to that new 
post office. This provides a faster, more reliable way of accessing your documents through 
GroupWise. 

You must move the document storage areas before the second post office data migration starts. 
Instructions for manually copying the document data to the planned destinations are provided at the 
appropriate point in the migration process. Do not move the document storage areas until you are 
instructed to do so.

GROUPWISE MIGRATION WORKSHEET

Under Item 11: WebAccess Agent Information, specify the full path to the WebAccess Agent startup file. The 
WebAccess Agent must run as root.

GROUPWISE MIGRATION WORKSHEET

Under Item 8: Post Office Information, specify the location where you want to move each remote document 
storage area for libraries in the post office.
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4.5 Handling the Potential Internet Agent Port Conflict
By default, Linux servers run the Postfix mail program. It typically uses an IP address of 127.0.0.1 and 
listens on port 25, which is the default for SMTP communication. By default, the GWIA binds to all IP 
addresses on the server and it also uses port 25. As a result, if Postfix is running on the Linux server, 
the GWIA cannot start because port 25 is already in use.

Occasionally, Postfix might be configured to listen on a different IP address. This would also cause a 
conflict if the GWIA is configured to use the same IP address. On the Linux server, use the following 
command to test for conflicts:

telnet IP_address 25

If you receive a response, then something is already listening on the specified IP address.

To resolve the conflict, you can bind the GWIA to a specific IP address that is not the address used by 
Postfix. As an alternative, you can disable Postfix. Disabling Postfix is not the preferred solution, 
because Postfix is responsible for sending system messages to the administrator.

If you decide that you want to disable Postfix, rather than binding the GWIA to a specific IP address, 
you can do it now, during the planning phase, so that the Linux server is ready for the GWIA to run 
on it.

1 In a terminal window at the Linux server, log in as root.
2 Enter the following commands:

/etc/init.d/postfix stop
chkconfig postfix off

3 To ensure that Postfix is not running, enter the following command:

ps -eaf | grep postfix

You should see no Postfix processes running. The server is now ready for the GWIA to run on it.

4.6 Handling SSL Certificate and Key Files
If your GroupWise agents use SSL on the source server, they need a certificate file and a key file on 
the destination Linux server. Although you can have the Server Migration Utility copy the existing 
files from the source server to the Linux server, this is not a viable permanent solution, because the 
original certificate file and key file have the IP address and hostname of the source server, not the 
destination Linux server. Unless the Linux server already has its own certificate file and key file, the 
recommendation is to generate a new certificate file and key file for the Linux server.

If you need to create new certificate and key files, you can do it now, during the planning phase, so 
that the Linux server is ready for the agents to run with SSL.

1 Create a new certificate file and key file for the Linux server as described in the following section 
of the GroupWise Administration Guide for your version of GroupWise:
 GroupWise 2012: “Server Certificates and SSL Encryption” in “Security Administration”

GROUPWISE MIGRATION WORKSHEET

Under Item 10: Internet Agent Information, mark whether you want to bind the GWIA to a specific IP address 
and specify the IP address.
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 GroupWise 8: “Server Certificates and SSL Encryption” in “Security Administration”
 GroupWise 7: “Server Certificates and SSL Encryption” in “Security Administration”

2 Save the new files in a convenient location on the Windows machine where you plan to run the 
Server Migration Utility.

3 On each Agent object in ConsoleOne, remove the path information for the files on the source 
server and, if necessary, update the file names of the certificate file and key file.
For GroupWise 2012 instructions, see the following sections of the GroupWise 2012 
Administration Guide:
 “Securing the Post Office with SSL Connections to the POA”
 “Securing the Domain with SSL Connections to the MTA”
 “Securing GWIA Connections with SSL”

For GroupWise 8 instructions, see the following sections of the GroupWise 8 Administration Guide:
 “Securing the Post Office with SSL Connections to the POA”
 “Securing the Domain with SSL Connections to the MTA”
 “Securing Internet Agent Connections with SSL”
 “Securing WebAccess Agent Connections with SSL”

For GroupWise 7 instructions, see the following sections of the GroupWise 7 Administration Guide:
 “Securing the Post Office with SSL Connections to the POA”
 “Securing the Domain with SSL Connections to the MTA”
 “Securing Internet Agent Connections with SSL”
 “Securing WebAccess Agent Connections with SSL”

4.7 Estimating Migration Time
There is no precise way to estimate how long it will take to migrate a particular post office or domain 
to Linux. The major determining factors are:

 Amount of data to migrate
 Connection speed between the source and destination servers

Fortunately, the Server Migration Utility makes it easy to perform any number of practice runs. You 
can safely run the Server Migration Utility on a live post office or domain as long as you do not make 
any of the configuration changes in ConsoleOne that would be made during a real migration.

You can expect to see the Migration Utility move about 6 GB of data per hour. If performance is 
substantially slower than this, check your network configuration for slow links and make sure that 
none of the following processes are running while you are migrating data:

 GroupWise maintenance activities such as Mailbox/Library Maintenance or Nightly User 
Upkeep

 Indexing of messages and documents
 Backups of GroupWise databases

GROUPWISE MIGRATION WORKSHEET

Under Item 12: SSL Information, specify the full path names of the certificate file and key file if your GroupWise 
agents use SSL. You can specify either new (preferable) or old files.
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These activities can hold files open and cause the Migration Utility to wait, thus slowing the 
migration process.

To speed migration, you might want to move agent log files out of post office directories and domain 
directories, especially if any of the following situations apply:

 You have been using the verbose log level.
 You retain log files for a long period of time.
 You have been generating MTA message log files.

Agent log files are stored in the following locations:

4.8 GroupWise Migration Worksheet

Agent Log File Location 

POA post_office\wpcsout\ofs

MTA domain\mslocal

GWIA domain\wpgate\gwia\000.prc

WebAccess Agent GroupWise 2012: N/A

GroupWise 8: domain\wpgate\webac80a\000.prc

GroupWise 7: domain\wpgate\webac70a\000.prc

Item Explanation

1) Source Platform

 NetWare

 Windows

Mark the platform you’re migrating the GroupWise component from.

See Section 4.1, “Gathering Source Server Information,” on page 21.

2) Source Server

 Server name

 IP address / 
hostname

Provide the name of the NetWare or Windows server, along with its IP address or 
hostname.

See Section 4.1, “Gathering Source Server Information,” on page 21.

3) Source Server 
Credentials

 User ID

 Password

Specify the user name that the Server Migration Utility can use to log in to the 
NetWare or Windows server and provide the password.

See Section 4.1, “Gathering Source Server Information,” on page 21.

4) Destination 
Server

 IP address / 
hostname

Specify the IP address or hostname of the Linux server.

See Section 4.2, “Gathering Destination Server Information,” on page 22.
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5) Destination 
Server Credentials

 Root user 
password

Specify the password for the root user on the Linux server.

See Section 4.2, “Gathering Destination Server Information,” on page 22.

6) RSA Key 
Fingerprint (optional)

Record the RSA key fingerprint for the Linux server.

See Section 4.2, “Gathering Destination Server Information,” on page 22.

7) Software 
Locations

 Software 
source

 Software 
destination

 Delete RPMs 
and temporary 
files?

Yes | No

List the full path where the GroupWise for Linux software is available and the full 
path on the Linux server where you want to temporarily store the software during 
the migration. Also mark whether you want to delete the temporary copy.

See Section 4.3, “Gathering Software Information,” on page 23.

8) Post Office 
Information

 Post office 
directory

 POA startup file

 Destination 
directory

 Run as root?

Yes | no

 Remote 
document 
storage areas

If you are migrating a post office, list the full path to the current post office 
directory, the full path and file name of the POA startup file, and the full path to the 
destination post office directory. Indicate whether you want to run the POA as 
root. If the post office has remote document storage areas for a libraries, specify 
where you want each storage area to be located on Linux.

See “Post Offices and Domains” on page 23.

9) Domain 
Information

 Domain 
directory

 MTA startup file

 Destination 
directory

 MTA working 
directory

 Run as root?

Yes | No

If you are migrating a domain, list the full path to the current domain directory, the 
full path and file name of the MTA startup file, the full path to the destination 
domain directory, and the full path to the MTA working directory (mslocal). Also 
indicate whether you want to run the MTA as root.

See “Post Offices and Domains” on page 23.

Item Explanation
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10) Internet Agent 
Information

 Startup file

 Run as root?

Yes | No

 Bind to 
address?

Yes | No

IP address

If you are migrating the GWIA along with a domain, list the full path and file name 
of the GWIA startup file. Also mark whether you want to run the GWIA as root.

See “Additional Agents for a Domain” on page 26.

Mark whether you want to bind the GWIA to a specific IP address. If you do, 
specify the address.

See Section 4.5, “Handling the Potential Internet Agent Port Conflict,” on page 28.

11) WebAccess 
Agent Information

 Startup file

If you are migrating the WebAccess Agent along with a domain, list the full path 
and file name of the WebAccess Agent startup file.

See “Additional Agents for a Domain” on page 26.

NOTE: The WebAccess Agent is not part of GroupWise 2012, but is part of earlier 
GroupWise versions.

12) SSL Information

 Certificate file

 Key file

If the GroupWise agents use SSL, provide the full path name of the certificate file 
and the key file.

See Section 4.6, “Handling SSL Certificate and Key Files,” on page 28.

Item Explanation
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5 5Meeting Migration Prerequisites

The GroupWise Server Migration Utility cannot run successfully unless the prerequisites described 
in this section are met.

 Section 5.1, “NetWare Prerequisites,” on page 33
 Section 5.2, “Windows Prerequisites,” on page 34

5.1 NetWare Prerequisites
In order for the Server Migration Utility to run successfully, the following prerequisites must be met:

 A drive is mapped to the NetWare Server. 

From the Windows workstation where you are running the Server Migration Utility, you need 
access to the source NetWare server where the directory structure for the post office or domain is 
located. This enables the Server Migration Utility to copy the GroupWise data to the destination 
Linux server and to identify existing agent startup files to transfer to Linux.

 The NCPFS package is installed on the Linux server. 
The NCPFS package enables the Server Migration Utility to create a NetWare Core Protocol 
(NCP) file system mount of the source NetWare server to the destination Linux server.
At the Linux server, use the following command to determine if the NCPFS package is installed:

rpm -qa | grep ncpfs

If it is installed, the NCPFS package is listed. If the NCPFS package is not installed, use the 
Install and Remove Software option of YaST to install it from your Linux installation media.

 The GroupWise Linux CD or Support Pack software is available. It must be the same 
GroupWise version that is installed on the source server. 
To prepare for the migration, the Server Migration Utility needs to copy the GroupWise agent 
and utility RPMs from an existing software location to a temporary location on the destination 
Linux server. You must use the version of GroupWise software that matches the version of 
GroupWise that is already installed. You cannot use the GroupWise Server Migration Utility to 
update post offices and domains from an earlier version of GroupWise during the migration 
process.
A GroupWise software distribution directory on a NetWare server does not contain GroupWise 
Linux software unless you have placed it there from a GroupWise for Linux DVD or software 
distribution directory.

 The Novell Client and ConsoleOne are installed on the Windows workstation. 
If you are running the Server Migration Utility at the workstation where you typically 
administer GroupWise, these programs are already available. If they are not available on your 
current workstation, you can obtain them from:
Your GroupWise Installation software (recommended)
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Novell Downloads (http://download.novell.com)

 The ssh daemon is running on the Linux server with ssh enabled for the root user. 
The ssh daemon is a secure shell program that allows the Server Migration Utility to log in to 
the destination Linux server as root and execute programs there. At the Linux server, use the 
following command to verify that the ssh daemon is running:

ps -eaf | grep sshd

If it is not running, use the following command to start it:

/etc/init.d/sshd start

You must also ensure that processes from outside the server’s firewall can communicate with the 
ssh daemon. In YaST, click Security and Users > Firewall. Click Next until you reach the list of 
available services on the server. Make sure that Secure Shell (ssh) is selected, then click Next until 
you reach the end of the firewall configuration process. Click Continue to save your settings and 
restart the firewall.

 The GroupWise client is installed on the Windows workstation. 
After you have done the initial copy of a post office and started the Linux POA, you use the 
Windows client to make sure that the user in the migrated post office can connect to his or her 
Online mailbox on the destination Linux server and that the mailbox contents have been 
transferred.

 Adequate disk space is available on the Linux server for the migration. 
Depending on how you want to set up your backup procedure for the domain or post office on 
Linux, you might need double the disk space occupied by the domain or post office so that you 
can maintain a current copy of the domain or post office to run your backup software against. To 
consider backup alternatives on Linux, see the following sections in the GroupWise 
Administration Guide for your version of GroupWise:
 GroupWise 2012: The GroupWise Target Service Agent is no longer available.
 GroupWise 8: “GroupWise Target Service Agent” and “GroupWise Database Copy Utility” 

in “Databases”
 GroupWise 7: “Target Service Agents” and “GroupWise Database Copy Utility” in 

“Databases”

5.2 Windows Prerequisites
In order for the GroupWise Server Migration Utility to run successfully, the following prerequisites 
must be met:

 A share on the Windows server provides read/write access to the domain or post office you 
are migrating. If you are not on the server where the share resides, a drive is mapped to the 
share. 

In order to provide access to the domain or post office data on the Windows server, you need to 
set up a share on that server that includes the domain or post office directory. The share needs to 
provide read/write access to the domain or post office directory for the user running the Server 
Migration Utility. This enables the Server Migration Utility to copy the GroupWise data from the 
Windows server to the destination Linux server and to access existing agent startup files so that 
existing configuration information can be transferred to Linux.
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If you run the Server Migration Utility on a Windows workstation, rather than on the Windows 
server where the domain or post office is located, you need to map a drive to the Windows 
server so that the Server Migration Utility can access the domain and post office data.

 The samba-client package is installed on the Linux server. 
The samba-client package provides the mount command so that the Server Migration Utility can 
create a Samba file system mount of the source Windows server to the destination Linux server.
At the Linux server, use the following command to determine if the samba-client package is 
installed:

rpm -qa | grep samba-client

If it is installed, the samba-client package is listed. If the samba-client package is not installed, 
use the Install and Remove Software option of YaST to install it from your Linux installation 
media.

 The Samba server is running on the Linux server and you have mapped a drive to the Samba 
share from Windows. 
The Samba server enables the Server Migration Utility to create a Samba file system mount of the 
source Window server to the destination Linux server.
At the Linux server, use the following command to determine if the Samba server is running:

ps -eaf | grep samba

If you see both the smbd and nmbd daemons running, the Samba server is running.
Use your typical method of drive mapping to map a drive from the Windows machine where 
you plan to run the Server Migration Utility to the Linux server. Use the following format to 
specify the location on Linux:

\\Linux_hostname\Samba_sharename\path

This provides access between the Windows machine and the destination Linux server.
If the Server Migration Utility is unable to establish a Samba mount, it tries a CIFS mount 
instead. If the CIFS mount also fails, make sure that the cifs-mount package is installed.

 The GroupWise Linux CD, DVD, or downloaded image is available. It must be the same 
GroupWise version that is installed on the source server. 
To prepare for the migration, the Server Migration Utility needs to copy the GroupWise agent 
and utility RPMs from an existing software location to a temporary location on the destination 
Linux server. You must use the version of GroupWise software that matches the version of 
GroupWise that is already installed. You cannot use the GroupWise Server Migration Utility to 
update post offices and domains from an earlier version of GroupWise during the migration 
process
A GroupWise software distribution directory on a Windows server does not contain GroupWise 
Linux software unless you have placed it there from a GroupWise for Linux DVD or software 
distribution directory.

 The Novell Client and ConsoleOne are installed where you are running the utility. 
If you are running the Server Migration Utility at the workstation where you typically 
administer GroupWise, these programs are already available. If you are running the utility on 
the Windows server, they might not be available. You can obtain them from:
Your GroupWise Installation software (recommended)
Novell Downloads (http://download.novell.com)

 The ssh daemon is running on the Linux server with ssh enabled for the root user. 
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The ssh daemon is a secure shell program that allows the Server Migration Utility to log in to 
the destination Linux server as root and execute programs there. At the Linux server, use the 
following command to verify that the ssh daemon is running:

ps -eaf | grep sshd

If it is not running, use the following command to start it:

/etc/init.d/sshd start

You must also ensure that processes from outside the server’s firewall can communicate with the 
ssh daemon. In YaST, click Security and Users > Firewall. Click Next until you reach the list of 
available services on the server. Make sure that Secure Shell (ssh) is selected, then click Next until 
you reach the end of the firewall configuration process. Click Continue to save your settings and 
restart the firewall.
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6 6Running the Server Migration Utility

After you have met the prerequisites listed in Chapter 5, “Meeting Migration Prerequisites,” on 
page 33, you are ready to run the GroupWise Server Migration Utility. The first few dialog boxes are 
the same, regardless of whether you are migrating a post office or a domain. This section describes 
those common dialog boxes. Chapter 7, “Migrating a Post Office and Its POA to Linux,” on page 41 
and Chapter 8, “Migrating a Domain and Its Agents to Linux,” on page 53 provide instructions for 
migrating specific GroupWise components. 

1 Make sure that the server you are migrating is not running any GroupWise maintenance 
processing, indexing, backups, or virus scanning.
Such activities on the server substantially slow down the migration process.

2 Start the Server Migration Utility by running gwsvrmig.exe in the directory you set up in 
Chapter 3, “Installing the Server Migration Utility,” on page 19.

3 Review the Server Migration Utility overview, then click Next.
4 Accept the license agreement, then click Next.
5 Select the platform you are migrating from (worksheet item 1), then click Next.
6 Make sure you have met the prerequisites for your source platform, as described in Chapter 5, 

“Meeting Migration Prerequisites,” on page 33, then click Next to display the Source Server 
page.

For information about why the Server Migration Utility needs the source server credentials and 
what the utility does with them, see the following section in the GroupWise Administration Guide 
for your version of GroupWise.
 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
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 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

7 Provide the source server information (worksheet item 2).
8 Provide the source server login information (worksheet item 3), then click Next to display the 

Destination Server page.

For information about why the Server Migration Utility needs the root password and what the 
utility does with it, see the following section in the GroupWise Administration Guide for your 
version of GroupWise:
 GroupWise 2012: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 8: “GroupWise Server Migration Utility” in “Security Policies”
 GroupWise 7: “GroupWise Server Migration Utility” in “Security Policies”

9 Provide the destination server information (worksheet item 4).
10 Provide the destination server login information (worksheet item 5), then click Next.

If this is the first time you have connected to this Linux server, you are prompted to verify the 
RSA key fingerprint.

11 Click Yes.
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12 Browse to and select the directory where the GroupWise Linux DVD or software distribution 
directory is available (worksheet item 7).
A GroupWise software distribution directory on a NetWare or Windows server does not contain 
GroupWise Linux software unless you have placed it there from a GroupWise Linux DVD or 
software distribution directory.

13 (Conditional) If you want to change the default, specify the full path to the directory on the 
Linux server where you want the GroupWise RPMs to be copied for use by the Server Migration 
Utility (worksheet item 7).
You can retain the default of deleting the RPMs and temporary files after installation. This 
temporary location is not related to a standard GroupWise software distribution directory.

14 Click Next to continue to the Component to Migrate page.

15 Continue with the task that you want to perform:
 Chapter 7, “Migrating a Post Office and Its POA to Linux,” on page 41
 Chapter 8, “Migrating a Domain and Its Agents to Linux,” on page 53
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NOTE: The Server Migration Utility cannot migrate the Monitor Agent. You must migrate it 
manually. See Chapter 15, “Manually Migrating Monitor to Linux,” on page 101.
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7 7Migrating a Post Office and Its POA to 
Linux

The GroupWise Server Migration Utility helps you migrate a post office and its POA to Linux.

 Section 7.1, “Selecting a Post Office to Migrate,” on page 42
 Section 7.2, “Verifying Remote Document Storage Areas,” on page 43
 Section 7.3, “Transferring SSL Certificate and Key Files,” on page 44
 Section 7.4, “Performing the First Stage of Post Office Data Migration,” on page 44
 Section 7.5, “Testing the First Stage of Post Office Data Migration,” on page 45
 Section 7.6, “Modifying Configuration Information in ConsoleOne,” on page 46
 Section 7.7, “Stopping the Original POA on the Source Server,” on page 50
 Section 7.8, “Performing the Second Stage of Post Office Data Migration,” on page 50
 Section 7.9, “Finishing the Post Office Migration,” on page 51
 Section 7.10, “Post-Migration Tasks for a Post Office,” on page 51
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7.1 Selecting a Post Office to Migrate
1 Start the Server Migration Utility and provide system information, as described in Chapter 6, 

“Running the Server Migration Utility,” on page 37.
2 (Conditional) If you are migrating a post office on a NetWare server: 

2a On the Component to Migrate page, click Auto-Detect to list identifiable post offices and 
domains.

2b (Conditional) If you want to change the post office destination from the default of /var/
opt/novell/groupwise/mail:
2b1 Select the post office, then click Edit.
2b2 In the Destination Path field, specify the full path to the post office directory (worksheet 

item 8).
2b3 Click OK to return to the Component to Migrate page.

3 (Conditional) If you are migrating a post office on a Windows server, or if the Auto-Detect feature 
did not identify any post offices on your NetWare server:
3a Click Add Post Office.
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3b Provide the requested information about the post office and its POA (worksheet item 8).
3c Click OK to return to the Component to Migrate page. 

The post office and POA that you identified are now listed.
If you receive an error indicating that the startup path does not match the database source 
path, edit the POA startup file (post_office.poa) and modify the /home switch to use a 
UNC path (\\server\volume\path) instead of a mapped drive path (drive:\path).

3d Select the post office to migrate,
4 Click Next.
5 (Conditional) If the post office has remote document storage areas, continue with Section 7.2, 

“Verifying Remote Document Storage Areas,” on page 43.
or
(Conditional) If you use SSL to secure the connections between agents, skip to Section 7.3, 
“Transferring SSL Certificate and Key Files,” on page 44.
or
Skip to Section 7.4, “Performing the First Stage of Post Office Data Migration,” on page 44.

7.2 Verifying Remote Document Storage Areas
For background information about this process, see Section 4.4.3, “Remote Document Storage Areas 
for a Post Office,” on page 27.

If the Server Migration Utility detects one or more remote document storage areas belonging to a post 
office, it provides a list of their locations. This page is informational and you should use it to note the 
location of your remote storage areas. 
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IMPORTANT: Do not move your remote storage areas at this time. Do not remove your remote 
storage areas until after the first stage of post office migration and prior to the second stage of post 
office migration.

1 Make sure that the list you made under worksheet item 8 matches the list displayed by the 
Server Migration Utility.

2 Click Next.
3 Continue with Transferring SSL Certificate and Key Files.

7.3 Transferring SSL Certificate and Key Files
For background information about this process, see Section 4.6, “Handling SSL Certificate and Key 
Files,” on page 28.

The Server Migration Utility can copy your certificate file and key file from the source server to the 
Linux server so that they are ready for use after you migrate the POA.

1 Select Yes.
2 Browse to and select the certificate file (worksheet item 12) that you want to copy to Linux.
3 Browse to and select the key file (worksheet item 12) that you want to copy to Linux.
4 Click Next.
5 Continue with Performing the First Stage of Post Office Data Migration.

7.4 Performing the First Stage of Post Office Data Migration
A summary of the information that the Server Migration Utility has gathered from you displays.

1 (Conditional) If the summary information is correct, click Migrate.
or
Click Back, change information as needed, then click Migrate.
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When the migration starts, the First Data Migration page keeps you informed about the progress 
of the post office migration with messages similar to the following: 

Creating directories on Linux server...
Copying files...
Installing files...
Creating source server mount on Linux server...
Migrating data...
Copying agent configuration to Linux server...
Configuring agents...
Removing mount point...

For details about what happens during the first stage, see Section 1.3, “Post Office Migration 
Process,” on page 12.
Depending on the size of the post office, the process can take several hours.

2 (Conditional) If you need to halt the process, click Stop. 
This returns you to the Summary page but does not delete files that have already been copied.

3 Continue with Testing the First Stage of Post Office Data Migration.

7.5 Testing the First Stage of Post Office Data Migration
After the first stage of the post office migration is complete, the Server Migration Utility prompts you 
to test the migration.

1 On the Windows workstation, log in to a migrated GroupWise mailbox.
Use the IP address of the destination Linux server and specify 1677 as the port number. This is 
the default POA client/server port number and is used by the Server Migration Utility when it 
configures the Linux POA. If you can log in and access the mailbox, it shows that the Linux POA 
is running for the migrated post office.

2 Verify that the contents of the migrated mailbox match the contents of the original mailbox.
If they match, the copy operation was successful.
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If the first stage of the post office migration was not successful, review Chapter 5, “Meeting 
Migration Prerequisites,” on page 33, then repeat the migration. If the first stage of the migration 
is still not successful using the Server Migration Utility, you can migrate the post office 
manually, as described in Chapter 11, “Manually Migrating a Post Office and Its POA to Linux,” 
on page 75.

3 (Conditional) If the migration test was successful, select both check boxes on the First Stage of 
Post Office Data Migration Complete page, then click Next.
The Server Migration Utility stops the Linux POA in preparation for the second stage of the post 
office migration and displays a list of manual tasks for you to complete before it can start the 
second stage of the post office migration.

4 Leave the Server Migration Utility running while you perform the list of tasks.
5 Continue with Modifying Configuration Information in ConsoleOne to perform the tasks.

7.6 Modifying Configuration Information in ConsoleOne

IMPORTANT: Do not proceed with the following steps unless you are ready to stop the original 
POA on the source server for the last time.

1 Start ConsoleOne on Windows.
2 Connect to the domain that owns the migrated post office.
3 Perform the following modifications to GroupWise objects:

 Section 7.6.1, “Reconfiguring the Migrated Post Office,” on page 47
 Section 7.6.2, “Reconfiguring the Migrated POA,” on page 47
 Section 7.6.3, “Handling Remote Document Storage Areas,” on page 47
 “Reconfiguring Remote Document Storage Areas” on page 48
 Section 7.6.4, “Reconfiguring SSL Settings,” on page 48
 Section 7.6.5, “Updating Post Office Links for WebAccess,” on page 49
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 Section 7.6.6, “Updating the POA IP Address,” on page 49
 Section 7.6.7, “Verifying the Post Office Configuration Changes,” on page 49

4 When you are finished working in ConsoleOne and have verified your configuration changes, 
skip to Section 7.7, “Stopping the Original POA on the Source Server,” on page 50.

7.6.1 Reconfiguring the Migrated Post Office

1 Browse to and right-click the Post Office object, then click Properties.
2 Click GroupWise > Identification.
3 In the UNC Path field, change the path to the location on the destination Linux server where you 

copied the post office. For example:

\\linuxsvr3\gwsystem\research

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a Linux 
path with front slashes in the UNC Path field, because backslashes are expected.

4 Click OK to save the new Linux path information for the post office.
5 Continue with Reconfiguring the Migrated POA.

7.6.2 Reconfiguring the Migrated POA

1 In ConsoleOne, browse to and right-click the POA object for the post office, then click Properties.
2 Click GroupWise > Identification.
3 In the Platform field, select Linux, then click Apply.
4 Click GroupWise > Log Settings.
5 Make sure that the Log File Path field is empty so that the Linux POA creates its log files in the 

default location (/var/log/novell/groupwise/post_office_name.poa) on the Linux server. 
6 Click OK to save the configuration information for the Linux POA.
7 (Conditional) If you need to copy document storage areas to the Linux server, continue with 

Handling Remote Document Storage Areas.
or
Skip to Section 7.6.7, “Verifying the Post Office Configuration Changes,” on page 49.

7.6.3 Handling Remote Document Storage Areas

For background information about this process, see Section 4.4.3, “Remote Document Storage Areas 
for a Post Office,” on page 27.

If the Server Migration Utility detected one or more remote document storage areas belonging to a 
post office, it provided a list of their locations as described in Section 7.2, “Verifying Remote 
Document Storage Areas,” on page 43. At this point, you must physically move the remote document 
storage areas to their new locations on the Linux server and reconfigure their associated Library 
objects for the new locations.

 “Moving Remote Document Storage Areas” on page 48
 “Reconfiguring Remote Document Storage Areas” on page 48
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Moving Remote Document Storage Areas

1 Mount each remote document storage area to the Linux server where you want the remote 
document storage area to reside.
If you need help with a mount command, see Section 1.1, “Mount Commands,” on page 11 to 
review the mount commands used by the Server Migration Utility.

2 On the Linux server, change to the directory where you had the Server Migration Utility store 
the Linux RPMs during the migration (worksheet item 7)
The default location is /tmp/groupwise/software/bin. At this point in the migration process, 
the GroupWise Database Copy utility (DBCopy) has been installed, so you can use it to 
manually copy the remote document storage areas.

3 Copy each remote document storage area to its planned destination (worksheet item 8), using 
the following dbcopy command:

./dbcopy -m -b /storage_area_directory /destination_directory

The -m switch indicates that DBCopy is being used for migration to Linux.The -b switch 
indicates that DBCopy is being used to migrate a documentation storage area containing 
document BLOB (binary large object) files. 

4 Continue with Reconfiguring Remote Document Storage Areas.

Reconfiguring Remote Document Storage Areas

1 In ConsoleOne, browse to and right-click a Library object for the post office, then click Properties.
2 Click GroupWise > Storage Areas.
3 Select a storage area, then click Edit.
4 In the Linux Path field, specify the full path for the remote document storage area, then click OK.

Do not edit the UNC path. Editing the UNC path might cause the path format to become invalid.
5 Repeat Step 3 and Step 4 for each storage area in the list, then click OK.
6 Repeat Step 1 through Step 6 for each library in the post office.
7 Continue with Reconfiguring SSL Settings.

7.6.4 Reconfiguring SSL Settings

If you have not already followed the general instructions in Section 4.6, “Handling SSL Certificate 
and Key Files,” on page 28:

If you have not already followed the general instructions in Section 4.6, “Handling SSL Certificate 
and Key Files,” on page 28:

1 In ConsoleOne, browse to and right-click the POA object for the post office, then click Properties.
2 Click GroupWise > SSL Settings.
3 In the Certificate file field, change the path to the location of the certificate file on the destination 

Linux server. For example:

/opt/novell/groupwise/agents/bin/certificate_file_name.crt

4 In the SSL key file field, change the path to the location of the SSL key file on the destination 
Linux server. For example:

/opt/novell/groupwise/agents/bin/key_file_name.key
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5 Click OK to save the changes.
6 (Conditional) If you are using WebAccess, continue with Updating Post Office Links for 

WebAccess.
or
Skip to Section 7.6.6, “Updating the POA IP Address,” on page 49.

7.6.5 Updating Post Office Links for WebAccess

1 In ConsoleOne, browse to and right-click the WebAccess object, then click Properties.
2 Click Post Office Links.
3 Select the appropriate post office and click Edit Link.
4 Select an Access Mode from the drop-down menu.
5 Fill in the required information for your new post office location.
6 Click OK twice to save your new settings.
7 Continue with Updating the POA IP Address.

7.6.6 Updating the POA IP Address

Updating the POA IP address must be the last configuration change you make in ConsoleOne. After 
you change the IP address, the POA can no longer communicate with the MTA because it is no longer 
using the IP address that the MTA is configured to expect.

1 In ConsoleOne, browse to and right-click the POA object for the post office, then click Properties.
2 Click GroupWise > Network Address.
3 In the TCP/IP Address field, specify the IP address of the destination Linux server.
4 Click OK to save the new IP address.
5 Continue with Verifying the Post Office Configuration Changes.

7.6.7 Verifying the Post Office Configuration Changes

You can verify that the configuration changes have been replicated to the domain at the POA Web 
console.

1 Display the POA Web console for the original POA.

http://source_server_address:port_number

For more information about the POA Web console, see “Using the POA Web Console” in “Post 
Office Agent” in the GroupWise 7 Administration Guide.

2 Click MTP Status to check the status of the link between the MTA for the domain and the 
original POA on the source NetWare or Windows server.
The Receive link should display Closed because the POA is now configured to communicate with 
the MTA on a new IP address.

3 Continue with Stopping the Original POA on the Source Server.
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7.7 Stopping the Original POA on the Source Server
Because you have migrated the post office to Linux, the original POA no longer has an active post 
office to service and the MTA can no longer communicate with it. Therefore, the original POA on the 
source server is no longer a necessary part of your GroupWise system.

1 Go to the source NetWare or Windows server where the original POA is still running.
2 Display the POA server console.
3 Stop the original POA on the source server.
4 Continue with Performing the Second Stage of Post Office Data Migration.

7.8 Performing the Second Stage of Post Office Data Migration
1 Return to the location where you are running the Server Migration Utility.

The Preparation for Second Stage of Post Office Data Migration page should still be displayed.

You should already have completed all of these tasks as described in Section 7.6, “Modifying 
Configuration Information in ConsoleOne,” on page 46.

2 Select the check box for each task that you have completed, then click Next to continue with the 
second stage of the post office migration. 
When the second stage of the post office migration starts, the Second Stage of Post Office Data 
Migration page keeps you informed about the progress of the migration with messages similar 
to the following: 

Creating source server mount point...

Migrating data...

Removing mount point...

For details about what goes on during the second stage, see Section 1.3, “Post Office Migration 
Process,” on page 12. 

3 Continue with Finishing the Post Office Migration.
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7.9 Finishing the Post Office Migration
When the second stage is finished, the Server Migration Utility gives you the opportunity to start the 
Linux POA immediately.

However, it is preferable to configure the Linux POA to run as a non-root user before you start it.

1 Access the Linux server, then follow the instructions in the following section of the GroupWise 
Installation Guide for your version of GroupWise.
 GroupWise 2012: “Running the Linux GroupWise Agents as a Non-root User” in “Installing 

GroupWise Agents”
 GroupWise 8: “Running the Linux GroupWise Agents As a Non-root User” in “Installing 

GroupWise Agents”
 GroupWise 7: “Running the Linux GroupWise Agents as a Non-root User” in “Installing 

GroupWise Agents”
2 Return to the Server Migration Utility, then select Start the Post Office Agent on the Linux Server.
3 Click Finish.
4 Continue with Post-Migration Tasks for a Post Office.

7.10 Post-Migration Tasks for a Post Office
1 Check the Server Migration Utility log file to verify the success of the migration.

The log file is named gwsvrmig_mmddyyyy_nnnn.log and is found in the utility installation 
directory if the utility can write to that location. Otherwise, it is found in the /temp directory. It 
provides a migration summary and a listing of all actions taken by the Server Migration Utility.

2 (Conditional) If you see problems in the utility log file, check the GroupWise Database Copy 
utility (DBCopy) log file to obtain additional detail. The DBCopy log file is named 
mmddgwbk.nnn and is found in the post office directory on the Linux server.

3 (Conditional) If you have problems starting the migrated POA, see Appendix A, 
“Troubleshooting Post-Migration Problems,” on page 111.
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4 (Conditional) If the post office migration is not successful using the Server Migration Utility, 
migrate the post office manually, as described in Chapter 11, “Manually Migrating a Post Office 
and Its POA to Linux,” on page 75.

5 Check the migrated POA startup file (post_office.poa in the /opt/novell/groupwise/
agents/share directory on the Linux server) to see if any startup switches have been 
commented out during migration, and adjust them as needed, for the new Linux environment.
The Server Migration Utility comments out any startup switches whose values contain NetWare 
or Windows paths or the IP address of the source server. 

6 Set up a GroupWise name server to help GroupWise clients connect to the new IP address, as 
described in the following section of the GroupWise Administration Guide for your version of 
GroupWise:
 GroupWise 2012: “Simplifying Client/Server Access with a GroupWise Name Server” in 

“Post Office Agent”
 GroupWise 8: “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 

Office Agent”
 GroupWise 7: “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 

Office Agent”
7 (Conditional) If you copied remote document storage areas to the Linux server during the 

migration process, copy them again with a slightly different dbcopy command:

./dbcopy -m -i mm-dd-yyyy -b /storage_area_directory 
                                          /destination_directory

This copies only the files that have been modified since you first copied the document storage 
area, like an incremental backup.

8 Review your scheduled backups to make sure that they are set to run correctly with the new 
system changes.

9 Make sure that your Restore Area is now available from the Linux POA.
10 (Conditional) If you want to use the Monitor Agent to monitor the migrated POA on Linux, 

migrate the Monitor Agent manually.
See Chapter 15, “Manually Migrating Monitor to Linux,” on page 101.

11 (Conditional) If you want to migrate domains now, see Chapter 8, “Migrating a Domain and Its 
Agents to Linux,” on page 53.

12 When you are completely finished with your migration to Linux, see Chapter 9, “What’s Next,” 
on page 67 for information about cleaning up the servers that you are no longer using for 
GroupWise.
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8 8Migrating a Domain and Its Agents to 
Linux

The GroupWise Server Migration Utility helps you migrate a domain and its MTA to Linux. 

 Section 8.1, “Selecting a Domain to Migrate,” on page 54
 Section 8.2, “Selecting Additional Agents to Migrate,” on page 55
 Section 8.3, “Transferring SSL Certificate and Key Files,” on page 56
 Section 8.4, “Preventing an Internet Agent Port Conflict,” on page 57
 Section 8.5, “Modifying Configuration Information in ConsoleOne,” on page 58
 Section 8.6, “Stopping the Original Domain Agents on the Source Server,” on page 61
 Section 8.7, “Migrating the Domain Data,” on page 61
 Section 8.8, “Finishing the Domain Migration,” on page 63
 Section 8.9, “Manually Migrating the MTA Working Directory,” on page 64
 Section 8.10, “Post-Migration Tasks for a Domain,” on page 64
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8.1 Selecting a Domain to Migrate

IMPORTANT: If the domain has gateways, you should stop them before proceeding with the 
domain migration.

1 Start the Server Migration Utility and provide system information, as described in Chapter 6, 
“Running the Server Migration Utility,” on page 37.

2 (Conditional) If you are migrating a domain on a NetWare server: 
2a On the Component to Migrate page, click Auto-Detect to list identifiable post offices and 

domains.

2b (Conditional) If you want to change the domain destination from the default /var/opt/
novell/groupwise/mail:
2b1 Select the domain, then click Edit.
2b2 In the Destination Path field, specify the full path to the domain directory (worksheet 

item 9).
2b3 Click OK to return to the Component to Migrate page.
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3 (Conditional) If you are migrating a domain on a Windows server, or if the Auto-Detect feature 
did not identify any domains on your NetWare server:
3a Click Add Domain.

3b Provide the requested information about the domain and its MTA (worksheet item 9).
3c Click OK to return to the Component to Migration page. 

The domain and MTA that you identified are now listed.
If you receive an error indicating that the startup path does not match the database source 
path, edit the MTA startup file (domain.mta) and modify the /home switch to use a UNC 
path (\\server\volume\path) instead of a mapped drive path (drive:\path).

3d Select the domain to migrate.
4 (Conditional) If the domain has a GWIA or a WebAccess Agent, continue with Selecting 

Additional Agents to Migrate.
or
Click Next, then skip to Section 8.3, “Transferring SSL Certificate and Key Files,” on page 56.

8.2 Selecting Additional Agents to Migrate
If the domain has agents in addition to the MTA:

1 Click Add Agent.
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2 In the Agent Type drop-down list, select the type of agent to add (Internet Agent or WebAccess 
Agent).

NOTE: The WebAccess Agent is not part of GroupWise 2012, but is part of earlier GroupWise 
versions.

3 In the Startup File field, browse to and select the agent startup file (worksheet item 10 or 
worksheet item 11).

4 Click OK.
5 (Conditional) If you need to add another agent for the domain, repeat Step 1 through Step 4.
6 When all domain agents are listed, click Next.
7 Continue with Transferring SSL Certificate and Key Files.

8.3 Transferring SSL Certificate and Key Files
For background information about this process, see Section 4.6, “Handling SSL Certificate and Key 
Files,” on page 28.

The Server Migration Utility can copy your certificate file and key file from the source server to the 
Linux server so that they are ready for use after you migrate the agents.

1 Select Yes.
2 Browse to and select the certificate file (worksheet item 12) that you want to copy to Linux.
3 Browse to and select the key file (worksheet item 12) that you want to copy to Linux.
4 Click Next.
5 (Conditional) If you are migrating the GWIA, continue with Preventing an Internet Agent Port 

Conflict.
or
Skip to Section 8.5, “Modifying Configuration Information in ConsoleOne,” on page 58.
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8.4 Preventing an Internet Agent Port Conflict
For background information about this issue, see Section 4.5, “Handling the Potential Internet Agent 
Port Conflict,” on page 28.

If you are migrating the GWIA, the Server Migration Utility helps you avoid a potential port or IP 
address conflict between the GWIA and Postfix, a common Linux mail program. 

1 Specify the IP address of the Linux server (worksheet item 10)
or
Select I have disabled Postfix on the Linux server.
If you select this option, make sure that Postfix is disabled. If it is not, the GWIA cannot start at 
the end of the migration process. If you did not disable Postfix during the planning stage, see 
Section 4.5, “Handling the Potential Internet Agent Port Conflict,” on page 28.

2 Click Next to display a list of manual tasks for you to complete before the Server Migration 
Utility can start the domain migration.
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3 Leave the Server Migration Utility running while you perform the list of tasks.
4 Continue with Modifying Configuration Information in ConsoleOne.

8.5 Modifying Configuration Information in ConsoleOne

IMPORTANT: Do not proceed with the following steps unless you are ready to stop the original 
domain agents on the source server for the last time.

1 Start ConsoleOne on Windows.
2 Connect to the source domain.
3 Perform the following modifications: to GroupWise objects:

 Section 8.5.1, “Reconfiguring the Internet Agent,” on page 58
 Section 8.5.2, “Reconfiguring the WebAccess Agent,” on page 58
 Section 8.5.3, “Reconfiguring SSL Settings,” on page 59
 Section 8.5.4, “Reconfiguring the MTA,” on page 59
 Section 8.5.5, “Reconfiguring the Domain,” on page 60
 Section 8.5.6, “Updating the IP Address of the MTA,” on page 60
 Section 8.5.7, “Verifying the Domain Configuration Changes,” on page 60

8.5.1 Reconfiguring the Internet Agent

If the domain has a GWIA:

1 In ConsoleOne, browse to and right-click the GWIA object for the domain, then click Properties.
2 Click GroupWise > Identification.
3 In the Platform field, select Linux, then click Apply.
4 Click GroupWise > Network Address.
5 In the TCP/IP Address field, specify the IP address of the destination Linux server, then click 

Apply.
6 Click GroupWise > Log Settings.
7 Make sure that the Log File Path field is empty so that the Linux GWIA creates its log files in the 

default location (/var/log/novell/groupwise/domain_name.gwia) on the Linux server.
8 Click OK to save the configuration information for the Linux GWIA.
9 (Conditional) If the domain has a WebAccess Agent, continue with Reconfiguring the 

WebAccess Agent
or
Skip to Section 8.5.3, “Reconfiguring SSL Settings,” on page 59.

8.5.2 Reconfiguring the WebAccess Agent

NOTE: The WebAccess Agent is not part of GroupWise 2012, but is part of earlier GroupWise 
versions.
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If the domain has a WebAccess Agent:

1 In ConsoleOne, browse to and right-click the WebAccess Agent object for the domain, then click 
Properties.

2 Click GroupWise > Identification.
3 In the Platform field, select Linux, then click Apply.
4 Click GroupWise > Network Address.
5 In the TCP/IP Address field, specify the IP address of the destination Linux server, then click 

Apply.
6 Click GroupWise > Log Settings.
7 Make sure that the Log File Path field is empty so that the Linux WebAccess Agent creates its log 

files in the default location (/var/log/novell/groupwise/domain_name.webac70a) on the 
Linux server.

8 Click OK to save the configuration information for the Linux WebAccess Agent.
The Server Migration Utility migrates the WebAccess Agent but not the WebAccess Application 
that is installed with your Web server. If you want to use a Linux Web server with WebAccess, 
you can follow the instructions in Section 14.2, “Manually Migrating the WebAccess and 
WebPublisher Applications to Linux,” on page 98 after you have finished migrating the domain.

9 Continue with Reconfiguring SSL Settings.

8.5.3 Reconfiguring SSL Settings

If you have not already followed the general instructions in Section 4.6, “Handling SSL Certificate 
and Key Files,” on page 28:

1 In ConsoleOne, browse to and right-click the MTA object for the domain, then click Properties.
2 Click GroupWise > SSL Settings.
3 In the Certificate file field, change the path to the location of the certificate file on the destination 

Linux server. For example:

/opt/novell/groupwise/agents/bin/certificate_file_name.crt

4 In the SSL key file field, change the path to the location of the SSL key file on the destination 
Linux server. For example:

/opt/novell/groupwise/agents/bin/key_file_name.key

5 Click OK to save the changes.
6 Continue with Reconfiguring the MTA.

8.5.4 Reconfiguring the MTA

1 In ConsoleOne, browse to and right-click the MTA object for the domain, then click Properties.
2 Click GroupWise > Identification.
3 In the Platform field, select Linux, then click Apply.
4 Click GroupWise > Log Settings.
5 Make sure that the Log File Path field is empty so that the Linux MTA creates its log files in the 

default location (/var/log/novell/groupwise/domain_name.mta) on the Linux server.
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6 Click OK to save the configuration information for the Linux MTA.
7 Continue with Section 8.5.5, “Reconfiguring the Domain,” on page 60.

8.5.5 Reconfiguring the Domain

1 Browse to and right-click the Domain object, then click Properties.
2 Click GroupWise > Identification.
3 In the UNC Path field, change the path to the location on the destination Linux server where you 

copied the domain. For example:

\\linuxsvr3\gwsystem\provo1

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a Linux 
path with front slashes in the UNC Path field, because backslashes are expected.

4 Click OK to save the new Linux path information for the domain.
5 Continue with Updating the IP Address of the MTA.

8.5.6 Updating the IP Address of the MTA

Updating the MTA IP address information must be the last configuration change you make in 
ConsoleOne. After you change the MTA IP address, the MTA can no longer communicate with other 
GroupWise agents because it is no longer using the IP address that the other GroupWise agents are 
configured to expect.

NOTE: Unlike the MTA, the IP address for the GWIA and the WebAccess Agent must be updated 
before you reconfigure the domain, because you cannot access objects properties for the GWIA and 
the WebAccess Agent after you reconfigure the domain.

1 In ConsoleOne, browse to and right-click the MTA object for the domain, then click Properties.
2 Click GroupWise > Network Address.
3 In the TCP/IP Address field, specify the IP address of the destination Linux server.
4 Click OK to save the new IP address for the MTA.
5 Continue with Verifying the Domain Configuration Changes.

8.5.7 Verifying the Domain Configuration Changes

When the configuration changes have been replicated, the link from the MTA to other MTAs in your 
GroupWise system reflects the Linux location. You can see this in ConsoleOne and at the MTA Web 
console.

 “Using ConsoleOne” on page 60
 “Using the MTA Web Console” on page 61

Using ConsoleOne

1 In ConsoleOne, browse to and select the Domain object for the domain you are migrating, then 
click Tools > GroupWise Utilities > Link Configuration.

2 In the Inbound Links box, double-click a domain that links to the domain you are migrating.
The IP Address field should display the new Linux IP address for the domain you are migrating.
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3 Click Cancel, then click File > Exit to exit the Link Configuration utility.
4 Skip to Stopping the Original Domain Agents on the Source Server.

Using the MTA Web Console

1 Display the MTA Web console for the original MTA.

http://source_server_address:port_number

For more information about the MTA Web console, see the following section in the GroupWise 
Administration Guide for your version of GroupWise:
 GroupWise 2012: “Using the MTA Web Console” in “Message Transfer Agent”
 GroupWise 8: “Using the MTA Web Console” in “Message Transfer Agent”
 GroupWise 7: “Using the MTA Web Console” in “Message Transfer Agent”

2 Click Links to check the status of the links between the original MTA on the source server and 
other domains and post offices in your GroupWise system.
The links should display Closed because the MTA is now configured to communicate on a new IP 
address.

3 Continue with Stopping the Original Domain Agents on the Source Server.

8.6 Stopping the Original Domain Agents on the Source Server
Because you have reconfigured the domain to for its Linux location, the original MTA, GWIA, and 
WebAccess Agent on the source server no longer have an active domain to service, and other agents 
in the GroupWise system can no longer communicate with them. Therefore, the domain agents on 
the source server are no longer a necessary part of your GroupWise system.

1 Go to the source NetWare or Windows server where the original MTA and other domain agents 
are still running.

2 Display the MTA server console for the original MTA.
3 Stop the original MTA on the source server.
4 (Conditional) If applicable, stop the original GWIA on the source server.
5 (Conditional) If applicable, stop the original WebAccess Agent on the source server.
6 Continue with Migrating the Domain Data.

8.7 Migrating the Domain Data
1 Return to where you are running the Server Migration Utility.
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The Domain Preparation page should still be displayed.

2 Select the check box for each task you have completed, then click Next to display a summary of 
the information that the Server Migration Utility has gathered from you.

3 If the information is correct, click Migrate.
or
Click Back to change information as needed.
When the domain migration starts, the Domain Data Migration page keeps you informed about 
the progress of the domain migration with messages similar to the following: 

Creating directories on Linux server...
Copying files...
Installing files...
Creating source server mount on Linux server...
Migrating data...
Copying agent configuration to Linux server...
Configuring agents...
Removing mount point...

For details about what happens, see Section 1.4, “Domain Migration Process,” on page 14.
If you need to halt the process, click Stop. This returns you to the Summary page but does not 
delete files that have already been copied.

4 Continue with Finishing the Domain Migration.
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8.8 Finishing the Domain Migration
When the domain migration is completed, the Server Migration Utility gives you the opportunity to 
start the Linux MTA and other agents immediately. 

However, it is preferable to configure the Linux agents to run as a non-root user before you start 
them.

1 Access the Linux server, then follow the instructions in the GroupWise Installation Guide for your 
version of GroupWise:
 GroupWise 2012: “Running the Linux GroupWise Agents as a Non-root User” in “Installing 

GroupWise Agents”
 GroupWise 8: “Running the Linux GroupWise Agents As a Non-root User” in “Installing 

GroupWise Agents”
 GroupWise 7: “Running the Linux GroupWise Agents as a Non-root User” in “Installing 

GroupWise Agents”
2 Return to the Server Migration Utility, then select the check box for each agent that you want to 

start.
3 (Conditional) If you have more GroupWise domains or post offices to migrate, select Migrate 

Another Domain or Post Office to return to the Component to Migrate page and select another 
GroupWise component to migrate from the same source server to the same destination server.

4 Click Finish.
5 (Conditional) If necessary, continue with Manually Migrating the MTA Working Directory.

or
Skip to Section 8.10, “Post-Migration Tasks for a Domain,” on page 64.
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8.9 Manually Migrating the MTA Working Directory
If the MTA’s working directory (mslocal) was located where the Server Migration Utility could not 
copy it, such as on a different volume of a NetWare server from where the domain directory was 
located:

1 Copy the mslocal directory and its contents to the desired location on the Linux server.
2 Edit the MTA startup file (domain.mta in the /opt/novell/groupwise/agents/share 

directory).
3 Set the --work switch to the new location of the mslocal directory.
4 Start or restart the Linux MTA, so that it reads its modified startup file, as described in the 

following section in the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Starting the Linux Agents as Daemons” in “Installing GroupWise 

Agents”
 GroupWise 8: “Starting the Linux GroupWise Agents as Daemons” in “Installing 

GroupWise Agents”
 GroupWise 7: “Starting the Linux GroupWise Agents as Daemons” in “Installing 

GroupWise Agents”
5 Continue with Post-Migration Tasks for a Domain.

8.10 Post-Migration Tasks for a Domain
1 Check the Server Migration Utility log file to verify the success of the migration.

The log file is named gwsvrmig_mmddyyyy_nnnn.log and is found in the utility installation 
directory if the utility can write to that location. Otherwise, it is found in the /temp directory. It 
provides a migration summary and a listing of all actions taking by the Server Migration Utility.

2 If you see problems in the utility log file, check the GroupWise Database Copy utility (DBCopy) 
log file to obtain additional detail. The DBCopy log file is named mmddgwbk.nnn and is found in 
the domain directory on the Linux server.

3 If the domain migration is not successful using the Server Migration Utility, migrate the domain 
manually, as described in Chapter 12, “Manually Migrating a Domain and Its MTA to Linux,” on 
page 85.

4 Check the migrated agent startup files (domain.mta, gwia.cfg, and webac70a.waa in the /opt/
novell/groupwise/agents/share directory on the Linux server) to see if any startup switches 
have been commented out during migration, and as needed, adjust them for the new Linux 
environment.
The Server Migration Utility comments out any startup switches whose values contain NetWare 
or Windows paths or the IP address of the source server. 

5 If the domain has gateways, leave them where they are on the source server or consolidate them 
onto a single NetWare or Linux server.
GroupWise gateways cannot be migrated to Linux because there are no versions that run on 
Linux. You must keep them on the platform where they are currently running. If you set up a 
domain solely for gateways on your source platform and set up all gateways in that domain, it 
simplifies gateway administration after the rest of your GroupWise system has been migrated to 
Linux.

6 If you want to use the Monitor Agent to monitor the migrated agents on Linux, migrate the 
Monitor Agent manually.
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See Chapter 15, “Manually Migrating Monitor to Linux,” on page 101.
7 When you are completely finished with your migration to Linux, see Chapter 9, “What’s Next,” 

on page 67 for information about cleaning up the servers that you are no longer using for 
GroupWise.
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9 9What’s Next

After you have migrated all your GroupWise post offices and domains to Linux, you have NetWare 
or Windows servers that are no longer being used for GroupWise. If you plan to use those servers for 
other purposes in the future, you need to remove the GroupWise data and software from them.

 Section 9.1, “Directories,” on page 67
 Section 9.2, “NetWare Software,” on page 67
 Section 9.3, “Windows Software,” on page 68

9.1 Directories
Remove the following directories from NetWare and Windows servers:

The links provide information about the directories so that you can identify them on the source 
server.

9.2 NetWare Software
For a NetWare server, follow the instructions in the GroupWise Installation Guide for your version of 
GroupWise:

 GroupWise 2012: N/A.
 GroupWise 8: “Uninstalling the NetWare GroupWise Agents” in “Installing GroupWise Agents”
 GroupWise 7: “Uninstalling the NetWare GroupWise Agents” in “Installing GroupWise Agents”

Be sure to remove the migrated agents from the NetWare autoexec.ncf file so that the server does 
not try to start the migrated agents automatically when it is restarted.

GroupWise 2012 Directories GroupWise 8 Directories GroupWise 7 Directories

 Domain directory

 Post office directory

 MTA working directory

 (if it is not under the domain)

 Software distribution directory

 Domain directory

 Post office directory

 MTA working directory

 (if it is not under the domain)

 Software distribution directory

 Domain directory

 Post office directory

 MTA working directory

 (if it is not under the domain)

 Software distribution directory
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9.3 Windows Software
For a Windows server, follow the instructions in the GroupWise Installation Guide for your version of 
GroupWise:

 GroupWise 2012: “Uninstalling the Windows GroupWise Agents” in “Installing GroupWise 
Agents”

 GroupWise 8: “Uninstalling the Windows GroupWise Agents” in “Installing GroupWise 
Agents”

 GroupWise 7: “Uninstalling the Windows GroupWise Agents” in “Installing GroupWise 
Agents”
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II IIManual Server Migration

This section describes the manual steps for moving existing GroupWise 7 or GroupWise 8 users, post 
offices, and domains from NetWare or Windows to Linux. It can also be used for moving existing 
GroupWise 2012 users, post offices, and domains from Windows to Linux. GroupWise 2012 is not 
available on NetWare.

This section is designed to help those who might have a domain or post office where the Server 
Migration Utility is not fully successful in migrating the GroupWise data.

IMPORTANT: If you have GroupWise 6.x or 5.x, review the “Update” section of the GroupWise 7 
Installation Guide or the GroupWise 8 Installation Guide to acquaint yourself with the issues involved in 
updating from one version of GroupWise to another. You should update your GroupWise system to 
GroupWise 7 or 8 before migrating it to Linux.

If your GroupWise system is currently on NetWare and you are updating to GroupWise 2012, you 
must migrate to Linux or Windows first, then update to GroupWise 2012.

 Chapter 10, “Transitioning GroupWise Administration to Linux,” on page 71
 Chapter 11, “Manually Migrating a Post Office and Its POA to Linux,” on page 75
 Chapter 12, “Manually Migrating a Domain and Its MTA to Linux,” on page 85
 Chapter 13, “Manually Migrating the Internet Agent to Linux,” on page 91
 Chapter 14, “Manually Migrating WebAccess to Linux,” on page 95
 Chapter 15, “Manually Migrating Monitor to Linux,” on page 101
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10 10Transitioning GroupWise Administration 
to Linux

You migrate your GroupWise system from NetWare or Windows to Linux one post office and 
domain at a time. During the migration process, your system has domains and post offices on various 
platforms. You might use ConsoleOne on both Windows and Linux to administer domains and post 
offices located on any platform. 

This section helps you set up the cross-platform connections that enable ConsoleOne to successfully 
access GroupWise databases on any platform.

 Section 10.1, “Using Windows ConsoleOne to Access Domains and Post Offices on Linux,” on 
page 71

 Section 10.2, “Using Linux ConsoleOne to Access Domains and Post Offices on NetWare or 
Windows,” on page 72

 Section 10.3, “Migrating eDirectory to Linux,” on page 73

10.1 Using Windows ConsoleOne to Access Domains and Post 
Offices on Linux
In order for you to be able to use ConsoleOne on Windows to administer GroupWise domains, post 
offices, and agents that are located on Linux, the Linux servers where the domains, post offices, and 
agents are located must be accessible from Windows.

 Section 10.1.1, “Making a Linux Server Visible from Windows,” on page 71
 Section 10.1.2, “Accessing a Domain or Post Office on Linux from Windows ConsoleOne,” on 

page 72

10.1.1 Making a Linux Server Visible from Windows

To make a Linux server visible from Windows, you need to configure it so that you can map a drive 
to it as if it were a Windows server.
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10.1.2 Accessing a Domain or Post Office on Linux from Windows 
ConsoleOne

After you have made the Linux server visible from Windows:

1 Map a drive to the domain directory on the Linux server.
2 In Windows ConsoleOne, click Tools > GroupWise System Operations > Select Domain. 
3 Browse to and select the domain directory, then click OK.

You can now use Windows ConsoleOne to administer all GroupWise objects that belong to the 
domain that is located on Linux.

10.2 Using Linux ConsoleOne to Access Domains and Post 
Offices on NetWare or Windows
In order for you to be able to use ConsoleOne on Linux to administer GroupWise domains, post 
offices, and agents that are located on NetWare or Windows, the NetWare or Windows servers where 
the domains, post offices, and agents are located must be accessible from Linux.

 Section 10.2.1, “Making a NetWare or Windows Server Visible from Linux,” on page 72
 Section 10.2.2, “Accessing a Domain or Post Office on NetWare or Windows from Linux 

ConsoleOne,” on page 73

10.2.1 Making a NetWare or Windows Server Visible from Linux

To make a NetWare or Windows server visible from Linux, you mount the directory you need to 
access as a Linux file system.

 Operating System  Connection Method

Open Enterprise 
Server (OES) Linux

Use the NetWare Core Protocol (NCP) Server to create an NCP volume on the Linux 
server that will be visible from Windows just as a NetWare volume would be.

On the Linux server, become root, then enter the following commands:

ncpcon create volume volume_name directory
ncpcon set cross_protocol_locks=1

From a Windows workstation or server where the Novell client is installed, you can now 
use the Novell Map Network Drive feature to map a drive to the volume on your Linux 
server, and Windows-type file locking is respected by Linux.

For more information, see “Using NetWare Core Protocol to Connect from Windows to an 
OES Linux Server” in “System” in the GroupWise 2012 Administration Guide.

SUSE Linux 
Enterprise Server 
(SLES)

Use Samba to create a Windows share on the Linux server that will be visible from 
Windows just as a directory on another Windows server would be. For instructions on 
setting up a Samba share, see “Using Samba to Connect from Windows to a SLES 
Server” in “System” in the GroupWise 2012 Administration Guide.

From a Windows workstation or server, you can now use the Windows Map Network 
Drive feature to map a drive to the directory on your Linux server.
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Table 10-1   Creating a Connection from Linux to NetWare or Windows

10.2.2 Accessing a Domain or Post Office on NetWare or Windows from Linux 
ConsoleOne

After you have made the NetWare or Windows server visible from Linux:

1 Mount the domain directory to the Linux server.
2 In Linux ConsoleOne, authenticate to the eDirectory tree where the Domain object is located.
3 Click Tools > GroupWise System Operations > Select Domain. 
4 Browse to and select the domain directory, then click OK.

You can now use Linux ConsoleOne to administer all GroupWise objects that belong to the domain 
that is located on NetWare or Windows.

10.3 Migrating eDirectory to Linux
ConsoleOne modifies information stored in eDirectory. Novell eDirectory is available on NetWare, 
Linux, and Windows. eDirectory can be in use on any of these platforms when you are migrating 
your GroupWise system to Linux.

As part of the migration process, you might want to migrate eDirectory to Linux. Step-by-step 
instructions for migrating eDirectory to Linux are beyond the scope of the GroupWise Installation 
Guide, but the following documentation can provide assistance:

 If you are migrating to OES Linux, review Consolidating Data to OES Linux and Migrating Data 
from NetWare Servers in the Novell Server Consolidation and Migration Toolkit Administration Guide 
for your version of OES Linux. (http://www.novell.com/documentation/oes.html).

Operating 
System

Connection Method

NetWare: mount -t ncpfs NetWare_server_full_DNS_name_or_IP_address
               /Linux_mount_location/mount_point_directory
               -o user=fully_qualified_user_name
               -o ipserver=NetWare_server_full_DNS_name

A NetWare server full DNS name should have the format of mail2.provo.corporate.com. A 
fully qualified user name should have the format of Admin.Users.Corporate. A typical Linux 
mount location would be /mnt.

You can also use Novell Remote Manager (NRM) to create the NCP mount.

Windows: mount -t smbfs //Windows_server_name_or_IP_address/sharename
               /Linux_mount_location/mount_point_directory
               -o username=Windows_user_name

To use this command, the WINS protocol must be functioning properly on your network. The 
specified Windows user must have sufficient rights to access the post office directory. 
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 For situations not covered in the above guide, the eDirectory migration process includes 
installing eDirectory on Linux, creating an eDirectory replica on one or more Linux servers, and 
ultimately making one of the Linux replicas the master replica so that you can phase out the 
replicas on other platforms. For guidance, see the documentation for your version of eDirectory:
 eDirectory 8.8 (http://www.novell.com/documentation/edir88/index.html)
 eDirectory 8.7.3 (http://www.novell.com/documentation/edir873/index.html)
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11 11Manually Migrating a Post Office and Its 
POA to Linux

Manually migrating a post office and its POA to Linux includes copying directory structures to 
Linux, installing the POA software on Linux, and updating configuration information in 
ConsoleOne. 

 Section 11.1, “Preparing for the Post Office Migration,” on page 75
 Section 11.2, “Performing the Post Office Migration,” on page 76
 Section 11.3, “Reconfiguring the Post Office in ConsoleOne,” on page 80
 Section 11.4, “Finalizing the Post Office Migration,” on page 81

11.1 Preparing for the Post Office Migration
1 On the Linux server, become root in a terminal window.
2 Check the Linux server for adequate disk space for your backup solution of choice.

If you want to use the GroupWise Database Copy utility (DBCopy), you create a copy of the post 
office and then back up the copy, which requires double the post office size in disk space. For 
instructions, see the following section in the GroupWise Administration Guide for your version of 
GroupWise:
 GroupWise 2012: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 8: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 7: “GroupWise Database Copy Utility” in “Databases”

If you want to use the GroupWise Target Service Agent (TSAFSGW), this extra disk space is not 
required. However, having a recent complete online backup available can be helpful in a variety 
of circumstances. For instructions, see the following section in the GroupWise Administration 
Guide for your version of GroupWise:
 GroupWise 2012: The GroupWise Target Service Agent is no longer available.
 GroupWise 8: “GroupWise Target Service Agent” in “Databases”
 GroupWise 7: “Target Service Agents” in “Databases”

3 Make the Linux server visible from Windows.
This is necessary in order to perform administration tasks from Windows ConsoleOne during 
the post office migration process. For Linux server configurations to accomplish this, see 
Section 10.1.1, “Making a Linux Server Visible from Windows,” on page 71.

4 Make the NetWare or Windows server visible from Linux.
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This is necessary in order to use the Linux version of the GroupWise Database Copy utility 
(DBCopy) to copy the post office directory and its contents to the Linux server. The Linux 
version of DBCopy includes switches specialized for the post office migration process. For mount 
commands, see Section 10.2.1, “Making a NetWare or Windows Server Visible from Linux,” on 
page 72.

5 In a location on the Linux server that is accessible from Windows, create a new directory for 
your GroupWise system into which you plan to copy the post office directory. For example:

mkdir gwsystem

6 Install the GroupWise Database Copy utility (DBCopy) as described in the GroupWise 
Administration Guide for your version of GroupWise:
 GroupWise 2012: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 8: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 7: “GroupWise Database Copy Utility” in “Databases”

7 Install GroupWise Check (GWCheck) as described in the GroupWise Administration Guide for 
your version of GroupWise:
 GroupWise 2012: “GroupWise Check” in “Databases”
 GroupWise 8: “GroupWise Check” in “Databases”
 GroupWise 7: “GroupWise Check” in “Databases”

8 Continue with Performing the Post Office Migration.

11.2 Performing the Post Office Migration
In order to reduce the amount of time during which users cannot access their GroupWise mailboxes 
during the post office migration process, the post office data is copied twice. During the first copy, the 
POA is allowed to continue running and users can continue working. Because users are still accessing 
their mailboxes, some files are modified after being copied, thus necessitating the second copy of the 
files. For the second copy, the POA is stopped and users cannot access their Online mailboxes. 
However, only the modified files are copied, so the second copy procedure finishes much more 
quickly.

1 In the /opt/novell/groupwise/agents/bin directory, use DBCopy to copy the post office 
directory from the NetWare or Windows server to the new directory on the Linux server.

./dbcopy -m -f -p /post_office_directory /destination_directory

The -m switch indicates that DBCopy is being used for migration to Linux. This ensures that all 
directory names and file names are in lower case.
The -f switch indicates that this is the first pass of the migration process, during which the post 
office queue directories (wpcsin and wpcsout) are not copied. 

NOTE: If you are migrating a large and active post office, you can run DBCopy with the -f 
switch multiple times as you work towards the final copy.

The -p switch indicates that you are migrating a post office.
The post_office_directory variable includes the Linux mount location (for example, /mnt), 
the mount point directory, and the full path to the post office directory on the NetWare or 
Windows server. 
The destination_directory variable is the directory you created on the Linux server in Step 5 in the 
previous section.
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DBCopy creates a log file named mmddgwbk.nnn. The first four characters represent the date. A 
three-digit extension allows for multiple log files created on the same day. The log file is created 
at the root of the destination post office directory. Include the -v switch in the dbcopy command 
to enable verbose logging for the post office migration.
DBCopy is typically used for backing up your GroupWise system, but when you use the -m 
switch to migrate a post office to Linux, it changes directory names to lowercase as required on 
Linux and copies the message queue directories as well as the GroupWise databases in the post 
office.
This initial copy operation might require a substantial amount of time, but users are still able to 
access their mailboxes. Use the fastest network connection available for this copy operation.

2 (Conditional) If your Linux environment includes the X Window System, run the GroupWise 
Installation program to install the Linux POA for the post office, as described in the following 
section of the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Installing the Linux GroupWise Agents” in “Installing GroupWise 

Agents”
 GroupWise 8: “Installing the GroupWise Agents on Linux” in “Installing GroupWise 

Agents”
 GroupWise 7: “Installing the GroupWise Agents on Linux” in “Installing GroupWise 

Agents”
3 (Conditional) If the X Window System is not available, run the text-based GroupWise 

Installation program, as described in the following section of the GroupWise Installation Guide for 
your version of GroupWise:
 GroupWise 2012: “Installing GroupWise Components Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 8: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 7: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the GroupWise DVD or software distribution directory to the server 
where you have migrated the domain, then run the text-based Installation program to install the 
MTA on the Linux server.

4 Change to the /opt/novell/groupwise/agents/bin directory.
5 (Conditional) If the X Window System is available, enter the following command to start the 

Linux POA to verify that it runs for the post office in the new location:

./gwpoa --show --home /post_office_directory --noconfig 

The --show switch starts the POA with a user interface. The --home switch provides the location 
of the post office. The --noconfig switch prevents the POA from reading configuration 
information from eDirectory; the current eDirectory information is obsolete because the post 
office has been migrated. For purposes of this initial test, the POA starts with default 
configuration settings, including using any available IP address.
You should see the POA server console described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Starting the Linux Agents with a User Interface” in “Installing 

GroupWise Agents”
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 GroupWise 8: “Starting the Linux Agents with a User Interface” in “Installing GroupWise 
Agents”

 GroupWise 7: “Starting the Linux Agents with a User Interface” in “Installing GroupWise 
Agents”

If the POA server console does not appear, review the preceding steps to verify that all steps 
have been followed. For additional assistance, see the following section in GroupWise 
Troubleshooting 2: Solutions to Common Problems for your version of GroupWise:
 GroupWise 2012: “Post Office Agent Problems” in “Strategies for Agent Problems”
 GroupWise 8: “Post Office Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “Post Office Agent Problems” in “Strategies for Agent Problems”

6 (Conditional) If the X Window system is not available:
6a If LDAP authentication is not in use, enter the following command to start the Linux POA 

to verify that it runs for the post office in the new location:

./gwpoa --home /post_office_directory --noconfig 
        --ip POA_server_IP_address --httpport 7181

The --home switch provides the location of the post office. The --noconfig switch prevents 
the POA from reading configuration information from eDirectory; the current eDirectory 
information is obsolete because the post office has been migrated. The --ip switch provides 
the IP address of the server where the POA is running. The -httpport switch enables the 
POA Web console and provides the port number.
or
If LDAP authentication is enabled for the post office, enter the following command:

./gwpoa --home /post_office_directory --noconfig 
        --ip POA_server_IP_address --httpport 7181

--ldapipaddr LDAP_server_IP_address
--ldapport LDAP_port (if not the default of 389)

The --ldapipaddr switch provides the location of the LDAP server. The --ldapport switch is 
required only if the LDAP server communicates on a port other than the default of 389.

IMPORTANT: To simplify this test, do not use an SSL connection to the LDAP server.

6b Open a Web browser and display the following URL:

http://POA_server_IP_address:7181

You should see the POA Web console described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Monitoring the Linux GroupWise Agents from Your Web Browser” 

in “Installing GroupWise Agents”
 GroupWise 8: “Monitoring the Linux GroupWise Agents from Your Web Browser” in 

“Installing GroupWise Agents”
 GroupWise 7: “Monitoring the Linux GroupWise Agents from Your Web Browser” in 

“Installing GroupWise Agents”
If the POA Web console does not appear, review the preceding steps to verify that all steps 
have been followed. For additional assistance, see the following section in GroupWise 
Troubleshooting 2: Solutions to Common Problems for your version of GroupWise:
 GroupWise 2012: “Post Office Agent Problems” in “Strategies for Agent Problems”
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 GroupWise 8: “Post Office Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “Post Office Agent Problems” in “Strategies for Agent Problems”

7 (Conditional) If you have access to a GroupWise mailbox on the post office you have migrated, 
start the GroupWise client to further verify the functioning of the POA.

8 After verifying that the Linux POA runs successfully for the post office in the new location on 
Linux, stop the Linux POA, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: “Stopping the Linux GroupWise Agents” in “Installing GroupWise 

Agents”
 GroupWise 8: “Stopping the Linux GroupWise Agents” in “Installing GroupWise Agents”
 GroupWise 7: “Stopping the Linux GroupWise Agents” in “Installing GroupWise Agents”

9 (Conditional) If you are using SSL, create a new certificate file (file_name.crt) and a new key 
file (file_name.key) for the Linux server and place them in the /opt/novell/groupwise/
agents/bin directory, which is the default location where the POA looks for certificate files.
For instructions on creating certificate and key files, see the following section of the GroupWise 
Administration Guide for your version of GroupWise:
 GroupWise 2012: “Server Certificates and SSL Encryption” in “Security Administration”
 GroupWise 8: “Server Certificates and SSL Encryption” in “Security Administration”
 GroupWise 7: “Server Certificates and SSL Encryption” in “Security Administration”

10 (Conditional) If you are using LDAP authentication, copy the public root certificate file 
(file_name.der) from the LDAP server to the /opt/novell/groupwise/agents/bin 
directory.

11 (Conditional) If you are migrating a post office that has a library with a document storage area 
located outside the post office directory structure, decide how to handle the document storage 
area:
 Mount the document storage area: You can leave the document storage area on the 

NetWare or Windows server. To provide access, permanently mount the storage area 
directory to the Linux server where the post office is located, using the mount command 
provided in Section 10.2.1, “Making a NetWare or Windows Server Visible from Linux,” on 
page 72. 

 Migrate the document storage area: If you want to eliminate the NetWare or Windows 
server, you can migrate the document storage area to a convenient location on the Linux 
server. This also eliminates the need for the permanently mounted file system.

12 (Conditional) If you decide to migrate the document storage area, use the following DBCopy 
command to migrate the document storage area to the Linux server: 

./dbcopy -m -b /storage_area_directory /destination_directory

The -m switch indicates that DBCopy is being used for migration to Linux. This ensures that all 
directory names and file names are in lower case.
The -b switch indicates that DBCopy is being used to migrate a documentation storage area 
containing document BLOB (binary large object) files. 
The storage_area_directory variable includes the Linux mount location (for example, /mnt), 
the mount point directory, and the full path to the document storage area. 
The destination_directory variable is the location on the Linux server where you want to 
migrate the document storage area.
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DBCopy creates a log file named mmddgwbk.nnn. The first four characters represent the date. A 
three-digit extension allows for multiple log files created on the same day. The log file is created 
at the root of the destination document storage area directory. Include the -v switch in the 
dbcopy command to enable verbose logging for the storage area migration.

13 Notify users that they must exit the GroupWise client unless they are running in Caching mode.
Users in Caching mode do not need access to the post office in order to continue using 
GroupWise. However, they cannot send and receive new messages while the POA is not 
running.

14 Continue with Reconfiguring the Post Office in ConsoleOne.

11.3 Reconfiguring the Post Office in ConsoleOne
If the connection between Linux and Windows is set up correctly, as described in Step 3 in 
Section 11.1, “Preparing for the Post Office Migration,” on page 75, you can use Windows 
ConsoleOne to perform the reconfiguration of the post office. You can also use Linux ConsoleOne if 
desired.

1 In ConsoleOne, disable logins to the post office:
1a Browse to and right-click the Post Office object, then click Properties.
1b Click GroupWise > Client Access Settings.
1c Select Disable Logins, then click Apply to save the setting.

2 Update the configuration information for the POA:
2a Browse to and right-click the POA object for the post office, then click Properties.
2b Click GroupWise > Identification.
2c In the Platform field, make sure that Linux is selected.
2d Display the Network Address property page of the POA object.
2e In the TCP/IP Address field, specify the IP address of the Linux server.
2f Display the Log Settings property page of the POA object.

2g Make sure that the Log File Path field is empty so that the POA on Linux creates its log files 
in the default location (/var/log/novell/groupwise/post_office_name.poa) on the 
Linux server.

2h Click OK to save the new configuration information for the POA.
3 (Conditional) If you are using SSL, update the location for the certificate and key files:

3a Display the SSL Settings property page of the POA object.
3b Browse to and select the certificate file and the key file that you created for the Linux server 

in Step 9 in Section 11.2, “Performing the Post Office Migration,” on page 76.
3c Click OK to save the SSL information for the POA.

4 (Conditional) If you migrated a document storage area to the Linux server in Step 11 in 
Section 11.2, “Performing the Post Office Migration,” on page 76, update the location of the 
document storage area:
4a Browse to and right-click the Library object, then click Properties.
4b Click GroupWise > Storage Areas.
4c Select the storage area that you have migrated, then click Edit.
80 GroupWise Server Migration Guide



4d In the Linux Path field, provide the full path to the storage area from the point of view of the 
POA running on the Linux server.

4e Click OK twice to save the storage area information.
5 Update the location information for the post office:

5a Display the Identification property page of the Post Office object.
5b In the UNC Path field, change the path to the location on the Linux server where you copied 

the post office. For example:
\\linuxsvr3\gwsystem\research

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a 
Linux path with front slashes in the UNC Path field, because backslashes are expected.

5c Click OK to save the new path information for the post office.
6 Check the status of the link between the POA still running on NetWare or Windows and the 

MTA it communicates with:
6a At the MTA server console, use Options > Configuration Status.

or
At the MTA Web console, look on the Links page.
After the ConsoleOne updates that you have just made are processed by the MTA, 
including the post office location change, the link changes to Closed. The status must show 
as Closed before you finalize the migration.

7 Continue with Finalizing the Post Office Migration.

11.4 Finalizing the Post Office Migration
1 On the NetWare or Windows server, stop the POA for the post office. If multiple POAs are 

currently running for the post office, stop all POAs.
GroupWise users can no longer access their Online mailboxes.

2 On the Linux server, run DBCopy again to copy the post office:

./dbcopy -m -s -p /post_office_directory /destination_directory

The -s switch indicates that this is the second pass of the migration process, during which the 
post office queue directories (wpcsin and wpcsout) are copied. The second DBCopy process 
should be substantially shorter than the first one. 

3 (Conditional) If you migrated a document storage area to the Linux server in Step 11 in 
Section 11.2, “Performing the Post Office Migration,” on page 76, run DBCopy again to copy the 
document storage area and include files modified since the first copy:

./dbcopy -m -i mm-dd-yyyy -b /storage_area_directory /destination_directory

This copies only the files that have been modified since you first copied the document storage 
area, like an incremental backup

4 (Conditional) If your GroupWise system includes a GWIA that is used for POP and IMAP email 
clients, check the link between the GWIA and the post office:
4a In ConsoleOne, right-click the GWIA object, then click Properties.
4b Click Post Office Links.
4c Make sure that the link shows the correct IP address where the Linux POA for the migrated 

post office is now running.
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5 (Conditional) If your GroupWise system includes the WebAccess Agent, check the link between 
the WebAccess Agent and the migrated post office:
5a In ConsoleOne, right-click the WebAccess Agent object, then click Properties.
5b Click Post Office Links.
5c Make sure that the link shows the correct IP address where the Linux POA for the migrated 

post office is now running.
6 Start the Linux POA with or without a user interface, as described in the following section of the 

GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Starting the Linux Agents with a User Interface” in “Installing 

GroupWise Agents”
 GroupWise 8: “Starting the Linux Agents with a User Interface” or “Starting the Linux 

GroupWise Agents as Daemons” in “Installing GroupWise Agents”
 GroupWise 7: “Starting the Linux Agents with a User Interface” or “Starting the Linux 

GroupWise Agents as Daemons” in “Installing GroupWise Agents”
7 Enable user logins for the post office, as described in the following section of the GroupWise 

Administration Guide for your version of GroupWise. 
 GroupWise 2012: “Disabling and Enabling GroupWise Accounts” in “Users”
 GroupWise 8: “Disabling and Enabling GroupWise Accounts” in “Users”
 GroupWise 7: “Disabling and Enabling GroupWise Accounts” in “Users”

8 (Conditional) If necessary, provide GroupWise users with the new IP address where the Linux 
POA is now running, so that they can start GroupWise again and access their Online mailboxes 
on the Linux server.
If you are running a GroupWise name server, users are automatically redirected to the new IP 
address when they start GroupWise, as described in the following section of the GroupWise 
Administration Guide for your version of GroupWise. 
 GroupWise 2012: “Simplifying Client/Server Access with a GroupWise Name Server” in 

“Post Office Agent”
 GroupWise 8: “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 

Office Agent”
 GroupWise 7: “Simplifying Client/Server Access with a GroupWise Name Server” in “Post 

Office Agent”
9 When the Linux POA is running smoothly for the new post office location, delete the old post 

office directory structure from the NetWare or Windows server.
10 (Conditional) If you migrated a document storage area to the Linux server in Step 11 in 

Section 11.2, “Performing the Post Office Migration,” on page 76, delete the old document 
storage area on the NetWare or Windows server.

11 Set up a backup procedure for the post office in its new location on Linux.
If you want to use the GroupWise Database Copy utility (DBCopy), you create a copy of the post 
office and then back up the copy, which requires double the post office size in disk space. For 
instructions, see the following section in the GroupWise Administration Guide for your version of 
GroupWise:
 GroupWise 2012: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 8: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 7: “GroupWise Database Copy Utility” in “Databases”
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If you want to use the GroupWise Target Service Agent (TSAFSGW), this extra disk space is not 
required. However, having a recent complete online backup available can be helpful in a variety 
of circumstances. For instructions, see the following section in the GroupWise Administration 
Guide for your version of GroupWise:
 GroupWise 2012: The GroupWise Target Service Agent is no longer available.
 GroupWise 8: “GroupWise Target Service Agent” in “Databases”
 GroupWise 7: “Target Service Agents” in “Databases”

12 (Optional) Uninstall the old POA software to reclaim disk space on the NetWare or Windows 
server. 
See Chapter 9, “What’s Next,” on page 67.
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12 12Manually Migrating a Domain and Its 
MTA to Linux

Manually migrating a domain and its MTA to Linux includes copying directory structures to Linux, 
installing the MTA software on Linux, and updating configuration information in ConsoleOne. This 
section describes the manual steps involved in the process. 

 Section 12.1, “Preparing for the Domain Migration,” on page 85
 Section 12.2, “Performing the Domain Migration,” on page 86
 Section 12.3, “Reconfiguring the Domain in ConsoleOne,” on page 88
 Section 12.4, “Finalizing the Domain Migration,” on page 89

12.1 Preparing for the Domain Migration
1 On the Linux server, become root in a terminal window.
2 Check the Linux server for adequate disk space for your backup solution of choice.

If you want to use the GroupWise Database Copy utility (DBCopy), you create a copy of the post 
office and then back up the copy, which requires double the post office size in disk space. For 
instructions, see the following section in the GroupWise Administration Guide for your version of 
GroupWise:
 GroupWise 2012: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 8: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 7: “GroupWise Database Copy Utility” in “Databases”

If you want to use the GroupWise Target Service Agent (TSAFSGW), this extra disk space is not 
required. However, having a recent complete online backup available can be helpful in a variety 
of circumstances. For instructions, see the following section in the GroupWise Administration 
Guide for your version of GroupWise:
 GroupWise 2012: The GroupWise Target Service Agent is no longer available.
 GroupWise 8: “GroupWise Target Service Agent” in “Databases”
 GroupWise 7: “Target Service Agents” in “Databases”

3 Make the Linux server visible from Windows.
This is necessary in order to perform administration tasks from Windows ConsoleOne during 
the domain migration process. For Linux server configurations to accomplish this, Section 10.1.1, 
“Making a Linux Server Visible from Windows,” on page 71.

4 Make the NetWare or Windows server visible from Linux.
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This is necessary in order to use the Linux version of the GroupWise Database Copy utility 
(DBCopy) to copy the domain directory and its contents to the Linux server. The Linux version 
of DBCopy includes switches specialized for the domain migration process. For mount 
commands, see Section 10.2.1, “Making a NetWare or Windows Server Visible from Linux,” on 
page 72.

5 In a location on the Linux server that is accessible from Windows, create a new directory for 
your GroupWise system into which you plan to copy the domain directory. For example:

mkdir gwsystem

6 Install the GroupWise Database Copy utility (DBCopy) as described in the following section in 
the GroupWise Administration Guide for your version of GroupWise:
 GroupWise 2012: “Using DBCopy on Linux” in “Databases”
 GroupWise 8: “Using DBCopy on Linux” in “Databases”
 GroupWise 7: “Using DBCopy on Linux” in “Databases”

7 Continue with Performing the Domain Migration.

12.2 Performing the Domain Migration
1 On the NetWare or Windows server, stop the MTA for the domain.
2 (Conditional) If the domain has gateways, stop the gateways.
3 In the /opt/novell/groupwise/agents/bin directory, use DBCopy to copy the domain 

directory from the NetWare or Windows server to the new directory on the Linux server.

./dbcopy -m -d /domain_directory /destination_directory

The -m switch indicates that DBCopy is being used for migration to Linux. This ensures that all 
directory names and file names are in lower case.
The -d switch indicates that you are migrating a domain.
The domain_directory variable includes the Linux mount location (for example, /mnt), the 
mount point directory, and the full path to the domain directory on the NetWare or Windows 
server. 
The destination_directory variable is the directory you created on the Linux server in Step 5 in the 
previous section.
DBCopy creates a log file named mmddgwbk.nnn. The first four characters represent the date. A 
three-digit extension allows for multiple log files created on the same day. The log file is created 
at the root of the destination domain directory. Include the -v switch in the dbcopy command to 
enable verbose logging for the domain migration.
DBCopy is typically used for backing up your GroupWise system, but when you use the -m 
switch to migrate a domain, it changes directory names to lowercase as required on Linux and 
copies the message queue directories as well as the GroupWise databases in the domain.

4 (Conditional) If you are using the /work startup switch to place the MTA working directory 
(mslocal) outside the domain directory structure, relocate the directory and rename files:
4a Copy the mslocal directory to the Linux server so that no messages en route between users 

are lost.
4b In the mslocal directory structure, rename files and directories that contain uppercase 

letters to all lowercase.
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5 (Conditional) If your Linux environment includes the X Window System, run the GroupWise 
Installation program to install the Linux MTA for the domain, as described in the following 
section of the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Installing the Linux GroupWise Agents” in “Installing GroupWise 

Agents”
 GroupWise 8: “Installing the GroupWise Agents on Linux” in “Installing GroupWise 

Agents”
 GroupWise 7: “Installing the GroupWise Agents on Linux” in “Installing GroupWise 

Agents”
6 (Conditional) If the X Window System is not available, run the text-based GroupWise 

Installation program, as described in the following section of the GroupWise Installation Guide for 
your version of GroupWise:
 GroupWise 2012: “Installing GroupWise Components Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 8: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 7: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the GroupWise DVD or software distribution directory to the server 
where you have migrated the domain, then run the text-based Installation program to install the 
MTA on the Linux server.

7 Change to the /opt/novell/groupwise/agents/bin directory.
8 (Conditional) If the X Window System is available, enter the following command to start the 

Linux MTA to verify that it runs for the domain in the new location:

./gwmta --show --home /domain_directory

The --show switch starts the MTA with a user interface. The --home switch provides the location 
of the domain.
You should see the MTA server console described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Starting the Linux Agents with a User Interface” in “Installing 

GroupWise Agents”
 GroupWise 8: “Starting the Linux Agents with a User Interface” in “Installing GroupWise 

Agents”
 GroupWise 7: “Starting the Linux Agents with a User Interface” in “Installing GroupWise 

Agents”
If the MTA server console does not appear, review the preceding steps to verify that all steps 
have been followed. For additional assistance, see the following section of GroupWise 
Troubleshooting 2: Solutions to Common Problems for your version of GroupWise:
 GroupWise 2012: “Message Transfer Agent Problems” in “Strategies for Agent Problems”
 GroupWise 8: “Message Transfer Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “Message Transfer Agent Problems” in “Strategies for Agent Problems”

9 (Conditional) If the X Window system is not available:
9a Enter the following command to start the Linux MTA to verify that it runs for the domain in 

the new location:
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./gwmta --home /domain_directory --ip mta_server_ip_address 
--httpport 7180

The --home switch provides the location of the domain. The --ip switch provides the IP 
address of the server where the MTA is running. The -httpport switch enables the MTA 
Web console and provides the port number.
To simplify this test, do not use an SSL connection.

9b In an appropriate environment, open a Web browser and display the following URL:

http://mta_server_ip_address:7180

You should see the MTA Web console described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Monitoring the Linux GroupWise Agents from Your Web Browser” 

in “Installing GroupWise Agents”
 GroupWise 8: “Monitoring the Linux GroupWise Agents from Your Web Browser” in 

“Installing GroupWise Agents”
 GroupWise 7: “Monitoring the Linux GroupWise Agents from Your Web Browser” in 

“Installing GroupWise Agents”
If the MTA Web console does not appear, review the preceding steps to verify that all steps 
have been followed. For additional assistance, see the following section of GroupWise 
Troubleshooting 2: Solutions to Common Problems for your version of GroupWise:
 GroupWise 2012: “Message Transfer Agent Problems” in “Strategies for Agent 

Problems”
 GroupWise 8: “Message Transfer Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “Message Transfer Agent Problems” in “Strategies for Agent Problems”

10 After verifying that the MTA starts successfully for the domain in the new location on Linux, 
stop the MTA, as described in the following section of the GroupWise Installation Guide for your 
version of GroupWise:
 GroupWise 2012: “Stopping the Linux GroupWise Agents” in “Installing GroupWise 

Agents”
 GroupWise 8: “Stopping the Linux GroupWise Agents” in “Installing GroupWise Agents”
 GroupWise 7: “Stopping the Linux GroupWise Agents” in “Installing GroupWise Agents”

11 (Conditional) If you plan to use SSL on Linux, create new certificate and key files for the Linux 
server and place them in the /opt/novell/groupwise/agents/bin directory, the default 
location where the MTA looks for certificate and key files.
For instructions on creating certificate and key files, see the following section of the GroupWise 
Administration Guide for your version of GroupWise:
 GroupWise 2012: “Server Certificates and SSL Encryption” in “Security Administration”
 GroupWise 8: “Server Certificates and SSL Encryption” in “Security Administration”
 GroupWise 7: “Server Certificates and SSL Encryption” in “Security Administration”

12 Continue with Reconfiguring the Domain in ConsoleOne.
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12.3 Reconfiguring the Domain in ConsoleOne
If the connection between Linux and Windows is set up correctly, as described in Step 3 in 
Section 12.1, “Preparing for the Domain Migration,” on page 85, you can use Windows ConsoleOne 
to perform the reconfiguration of the post office. You can also use Linux ConsoleOne if desired.

1 In ConsoleOne, update the location information for the domain:
1a Browse to and right-click the Domain object, then click Properties.
1b Click GroupWise > Identification.
1c In the UNC Path field, change the path to the location on the Linux server where you 

migrated the domain. For example:
\\linuxsvr3\gwsystem\provo3

For a Linux server, ConsoleOne interprets the UNC path as a Linux path. Do not put a 
Linux path in the UNC Path field.

1d Click OK to save the new location information for the domain.
2 Update the configuration information for the MTA:

2a Browse to and right-click the MTA object for the domain, then click Properties.
2b Click GroupWise > Identification.
2c In the Platform field, make sure that Linux is selected.
2d Display the Network Address property page of the MTA object for the domain.
2e In the Network Address field, specify the IP address of the Linux server.
2f Click OK to save the new configuration information for the MTA.

3 (Conditional) If the domain that you migrated to Linux has gateways associated with it, reselect 
each gateway directory:
3a Browse to and select the Domain object.
3b Right-click a Gateway object, then click Properties.
3c Click GroupWise > Identification.
3d In the Subdirectory field, reselect the gateway directory.

If you do not have any gateway subdirectories to choose from, you have not successfully 
completed Step 1.

3e Click OK to save the gateway directory information.
3f Repeat Step 3a through Step 3e for each gateway that belongs to the domain.

4 Continue with Finalizing the Domain Migration.

12.4 Finalizing the Domain Migration
1 Start the Linux MTA with or without a user interface, as described in the following section of the 

GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Starting the Linux Agents with a User Interface” in “Installing 

GroupWise Agents”
 GroupWise 8: “Starting the Linux Agents with a User Interface” or “Starting the Linux 

GroupWise Agents as Daemons” in “Installing GroupWise Agents”
 GroupWise 7: “Starting the Linux Agents with a User Interface” or “Starting the Linux 

GroupWise Agents as Daemons” in “Installing GroupWise Agents”
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2 At the MTA server console or Web console, check to make sure that all links between the new 
Linux MTA and other domains and post offices are open.
If you have closed links, see the following section of GroupWise Troubleshooting 2: Solutions to 
Common Problems for your version of GroupWise:
 GroupWise 2012: “MTA Status Box Shows a Closed Location” in “Strategies for Agent 

Problems”
 GroupWise 8: “MTA Status Box Shows a Closed Location” in “Strategies for Agent 

Problems”
 GroupWise 7: “MTA Status Box Shows a Closed Location” in “Strategies for Agent 

Problems”
3 (Conditional) If the domain has gateways, start each gateway.
4 Set up a backup procedure for the domain in its new location on Linux, as described in the 

following sections in the GroupWise Administration Guide for your version of GroupWise:
 GroupWise 2012: “GroupWise Database Copy Utility” in “Databases”
 GroupWise 8: “GroupWise Target Service Agent” and “GroupWise Database Copy Utility” 

in “Databases”
 GroupWise 7: “Target Service Agents” and “GroupWise Database Copy Utility” in 

“Databases”
5 (Conditional) If the domain has a GWIA that is running on the same NetWare or Windows 

server where the domain directory was previously located, migrate the GWIA to the Linux 
server where the domain directory is now located, as described in Chapter 13, “Manually 
Migrating the Internet Agent to Linux,” on page 91.
After the domain has been migrated to Linux, the NetWare or Windows GWIA can continue 
receiving and queuing Internet messages, but it cannot pass them into the GroupWise system 
until the GWIA has been migrated to Linux along with its domain and MTA.

6 (Conditional) If the domain has a WebAccess Agent that is running on the same NetWare or 
Windows server where the domain directory was previously located, consider migrating the 
WebAccess Agent to the Linux server where the domain directory is now located, as described 
in Chapter 14, “Manually Migrating WebAccess to Linux,” on page 95.
Because it is common for the WebAccess Agent to run on a different server from where its 
domain is located, there is no urgency about migrating it to Linux.

7 When the Linux MTA is running smoothly for the new domain location, and other GroupWise 
agents belonging to the domain have been migrated to Linux as needed, delete the old domain 
directory structure (and if applicable, the mslocal directory structure) from the NetWare or 
Windows server.

8 (Optional) Uninstall the old MTA software to reclaim disk space on the NetWare or Windows 
server. 
See Chapter 9, “What’s Next,” on page 67.
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13 13Manually Migrating the Internet Agent to 
Linux

Manually migrating the Internet Agent (GWIA) to Linux includes migrating its domain to Linux, 
then installing the GWIA software on Linux, updating GWIA configuration information in 
ConsoleOne, and copying queued Internet messages from the NetWare or Windows server to the 
Linux server. 

1 Migrate the GWIA’s domain to Linux, as described in Chapter 12, “Manually Migrating a 
Domain and Its MTA to Linux,” on page 85.
If you are using SSL, migrating the domain and its MTA includes creating a new certificate file 
(file_name.crt) and a new key file (file_name.key) for the Linux server and placing them in 
the /opt/novell/groupwise/agents/bin directory, as described in Step 11 in Section 12.2, 
“Performing the Domain Migration,” on page 86.

2 On the Linux server, become root in a terminal window.
3 Make the Linux server visible from Windows.

This is necessary in order to perform administration tasks from Windows ConsoleOne during 
the GWIA configuration process. For Linux server configurations to accomplish this, see 
Section 10.1.1, “Making a Linux Server Visible from Windows,” on page 71.

4 Install and configure the Linux GWIA, as described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Installing the GroupWise Internet Agent”
 GroupWise 8: “Installing the GroupWise Internet Agent”
 GroupWise 7: “Installing the GroupWise Internet Agent”

5 In ConsoleOne, update the GWIA property pages for the new location of the GWIA:
5a On the Identification property page of the GroupWise tab, set Platform to Linux, then click 

Apply.
5b On the Network Address property page of the GroupWise tab, specify the IP address or DNS 

hostname of the Linux server, then click Apply.
5c On the Log Settings property page of the GroupWise tab, if you have specified a directory 

path in the Log File Path field, delete the NetWare or Windows path, then click Apply.
On Linux, GWIA log files are stored in the /var/log/novell/groupwise/domain.gwia. 

5d On the SSL Settings property page of the GroupWise tab, if you have specified full paths in 
the Certificate File and SSL Key File fields, delete the NetWare or Windows path, then click 
Apply.
On Linux, the GWIA looks in the /opt/novell/groupwise/agents/bin directory for 
certificate and key files by default.

5e On the Server Directories tab, update the Conversion Directory and SMTP Queues Directory 
fields with corresponding Linux locations.

6 On the NetWare or Windows server, stop the GWIA.
Manually Migrating the Internet Agent to Linux 91

http://www.novell.com/documentation/gw8/pdfdoc/gw8_install/gw8_install.pdf#A8sx8kq
http://www.novell.com/documentation/gw7/pdfdoc/gw7_install/gw7_install.pdf#A8sx8kq


Internet messages cannot be received into your GroupWise system while the GWIA is stopped.
7 From Windows, copy the queued Internet messages in the GWIA SMTP queues directory on the 

NetWare or Windows server to the Linux server.

NOTE: Because of Step 3 above, the Linux server is already visible from Windows. If you prefer 
to perform the copy operation from Linux, you must first make the NetWare or Windows server 
visible from Linux, as described in Section 10.2.1, “Making a NetWare or Windows Server 
Visible from Linux,” on page 72.

The default GWIA SMTP queues directory is domain/wpgate/gwia. In this directory, four queue 
subdirectories are used for SMTP processing: send, receive, result, and defer. When you 
migrated the domain to Linux, DBCopy copied these queue directories and their contents to the 
Linux server along with the rest of the domain directory structure, but additional Internet 
messages might have arrived since that time. Therefore, you need to copy these queue 
directories again now that the GWIA has been stopped.
If you used the SMTP Queues Directory field on the Server Directories property page of the 
GWIA object in ConsoleOne or the /dhome switch in the gwia.cfg file to place the queue 
directories outside the domain directory structure, then DBCopy did not copy the queue 
directories. Copy the queue directories from the NetWare or Windows server to their default 
location in the domain directory structure or to another location of your choice on the Linux 
server. If you do not copy them to their default location, update the SMTP Queues Directory 
setting with the full path to the SMTP queues directory.

8 (Conditional) If Sendmail, Postfix, or any other SMTP daemon is enabled on your Linux server, 
disable it before starting the GWIA.
For example, use the following commands to stop and disable Postfix:

/etc/init.d/postfix stop
chkconfig postfix off

As an alternative, you can configure the GWIA to bind exclusively to the server IP address, so 
that the GWIA IP address does not conflict with the default Postfix IP address of 127.0.0.1 (the 
loopback address).
For instructions, see the following section in the GroupWise Administration Guide for your version 
of GroupWise:
 GroupWise 2012: “Binding the GWIA to a Specific IP Address” in “Internet Agent”
 GroupWise 8: “Binding the Internet Agent to a Specific IP Address” in “Internet Agent”
 GroupWise 7: “Binding the Internet Agent to a Specific IP Address” in “Internet Agent”

9 (Conditional) If you want to use the GWIA for POP3 and IMAP4 mail, make sure no POP3 or 
IMAP4 daemons are running on your Linux server.

10 Make sure that the MTA for the domain is running.
11 Start the Linux GWIA with or without a user interface, as described in the following section of 

the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Linux: Starting the GWIA” in “Installing the GroupWise Internet Agent”
 GroupWise 8: “Linux: Starting the Internet Agent” in “Installing the GroupWise Internet 

Agent”
 GroupWise 7: “Linux: Starting the Internet Agent” in “Installing the GroupWise Internet 

Agent”
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If the GWIA server console does not appear, or the GWIA Web console is not available in your 
Web browser, review the preceding steps to verify that all steps have been followed. For 
additional assistance, see the following section of GroupWise Troubleshooting 2: Solutions to 
Common Problems for your version of GroupWise:
 GroupWise 2012: “Internet Agent Problems” in “Strategies for Agent Problems”
 GroupWise 8: “Internet Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “Internet Agent Problems” in “Strategies for Agent Problems”

12 When the Linux GWIA is running smoothly for the new domain location, and other GroupWise 
agents belonging to the domain have been migrated to Linux as needed, delete the old domain 
directory structure from the NetWare or Windows server.

13 (Conditional) If the SMTP queue directory was located outside the domain directory structure, 
delete this directory and its contents from the NetWare or Windows server.

14 (Optional) Uninstall the old GWIA software to reclaim disk space on the NetWare or Windows 
server. 
See Chapter 9, “What’s Next,” on page 67.
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14 14Manually Migrating WebAccess to Linux

You can migrate just the WebAccess Agent, just the WebAccess Application, or both from NetWare or 
Windows to Linux. The process includes installing the WebAccess software on Linux, then 
transferring configuration information from old eDirectory objects to new eDirectory objects and 
from old startup files and configuration files on NetWare or Windows to new startup files and 
configuration files on Linux. 

 Section 14.1, “Manually Migrating the WebAccess Agent to Linux,” on page 95
 Section 14.2, “Manually Migrating the WebAccess and WebPublisher Applications to Linux,” on 

page 98

IMPORTANT: If you are updating to GroupWise 2012 as part of the migration process, you do not 
need to migrate the WebAccess Agent, because the WebAccess Agent is not part of GroupWise 2012.

14.1 Manually Migrating the WebAccess Agent to Linux

NOTE: This section does not apply to GroupWise 2012. GroupWise 2012 does not use the WebAccess 
Agent.

1 On the Linux server, become root in a terminal window.
2 (Conditional) If you are installing the WebAccess Agent on a server other than the one where its 

domain is located, provide access to the domain directory on the server where you are installing 
the Linux WebAccess Agent.
If the domain directory is located on another Linux server, use your mount command of choice. 
If the domain is located on a NetWare or Windows server, see Section 10.2.1, “Making a NetWare 
or Windows Server Visible from Linux,” on page 72 for suggested mount commands.
As an alternative to a permanent mount, and to provide better performance and stability, you 
can create a secondary domain and run a Linux MTA on the Linux server local to the WebAccess 
installation. For instructions, see the following section in the GroupWise Administration Guide for 
your version of GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “Creating a New Domain” in “Domains”
 GroupWise 7: “Creating a New Domain” in “Domains”

3 (Conditional) If your Linux environment includes the X Window System, run the GUI 
GroupWise Installation program to install the Linux WebAccess Agent software, as described in 
the following section in the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: N/A.
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 GroupWise 8: “Installing the Linux WebAccess Agent” in “Installing GroupWise 
WebAccess”

 GroupWise 7: “Installing the Linux WebAccess Agent” in “Installing GroupWise 
WebAccess”

4 (Conditional) If the X Window System is not available, run the text-based GroupWise 
Installation program instead, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 7: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the GroupWise DVD or software distribution directory to the server 
where you have migrated the domain, then run the text-based Installation program to install the 
WebAccess Agent on the Linux server.

5 Configure the WebAccess Agent, as described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “Configuring the Linux WebAccess Agent” in “Installing GroupWise 

WebAccess”
 GroupWise 7: “Configuring the Linux WebAccess Agent” in “Installing GroupWise 

WebAccess”
5a On the Gateway Directory page, specify a new name for the WebAccess gateway directory 

under wpgate in the domain directory, so that the old gateway directory and its contents 
are retained.

5b On the Gateway Object page, specify a new object name, so that the old WebAccess Agent 
object is retained.

6 In ConsoleOne, review the property pages for the old WebAccess Agent object and transfer any 
settings that you have customized on the on the old WebAccess Agent object to the new 
WebAccess Agent object.

IMPORTANT: The encryption key on the WebAccess Settings page is especially important. 
Check and transfer it if necessary.

7 Copy the commgr.cfg file from its location under the new WebAccess gateway directory:
domain_directory/wpgate/new_webaccess_agent_gateway_directory

to the WebAccess, and optionally WebPublisher, software directories:

/opt/novell/groupwise/webaccess
/opt/novell/groupwise/webpublisher

If you plan to run multiple WebAccess Agents for the domain, this step needs to be done only 
for the primary WebAccess Agent, as listed on the Environment property page of the 
GroupWise Provider object.

8 Review the existing WebAccess Agent startup file:
old_webaccess_agent_object_name.waa

located on the NetWare or Windows server in:
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and transfer any customized settings to the new WebAccess Agent startup file: 
new_webaccess_agent_object_name.waa

located on the following directory on the Linux server:
/opt/novell/groupwise/agents/share

9 Review the old Document Viewer Agent startup file (gwdva.dva) located on the NetWare or 
Windows server in the same directory with the WebAccess Agent startup file, and transfer any 
customized settings to the new Document Viewer Agent startup file on the Linux server.

10 Start the Linux WebAccess Agent with or without a user interface, as described in the following 
section of the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “Starting the Linux WebAccess Agent” in “Installing GroupWise 

WebAccess”
 GroupWise 7: “Starting the Linux WebAccess Agent” in “Installing GroupWise 

WebAccess”
If the WebAccess Agent server console does not appear, or if the WebAccess Agent Web console 
is not available in your Web browser, review the preceding steps to verify that all steps have 
been followed. For additional assistance, see the following section of GroupWise Troubleshooting 
2: Solutions to Common Problems for your version of GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “WebAccess Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “WebAccess Agent Problems” in “Strategies for Agent Problems”

11 After the new WebAccess Agent is running successfully, replace the old WebAccess Agent with 
the new WebAccess Agent in the WebAccess Application’s provider list:
11a In ConsoleOne, right-click the GroupWise Provider object, then click Properties.
11b In the GroupWise WebAccess Agent Information box, click Add.
11c Browse to and select the new WebAccess Agent object, then click OK to add it to the list of 

WebAccess Agents.
11d Select the old WebAccess Agent, then click Delete.
11e Click OK to save the updated WebAccess Agent list.

12 Stop the old WebAccess Agent on the NetWare or Windows server.
13 Delete the old WebAccess Agent object from eDirectory.
14 Delete the old WebAccess Agent gateway directory under wpgate in the domain directory. 
15 (Optional) Uninstall the old WebAccess Agent software to reclaim disk space on the NetWare or 

Windows server. 
See Chapter 9, “What’s Next,” on page 67.

NetWare: GroupWise 2012: N/A.

GroupWise 8: sys:\system\webac80a.waa

GroupWise 7: sys:\system\webac70a.waa

Windows: GroupWise 2012: N/A.

GroupWise 8: c:\Program Files\Novell\GroupWise Server\

WebAccess\webac80a.waa

GroupWise 7: c:\webacc\webac70a.waa
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14.2 Manually Migrating the WebAccess and WebPublisher 
Applications to Linux

NOTE: GroupWise 2012 does not include WebPublisher.

1 On the Linux server, become root in a terminal window.
2 Make sure that the Linux server already has Apache and Tomcat configured and running 

successfully and that you know the full path to the Apache and Tomcat root directories.
3 (Conditional) If your Linux environment includes the X Window System, run the GUI 

GroupWise Installation program to install and configure the Linux WebAccess Application, as 
described in the following section of the GroupWise Installation Guide for your version of 
GroupWise:
 GroupWise 2012: “Linux: Setting Up GroupWise WebAccess” in “Installing GroupWise 

WebAccess”
 GroupWise 8: “Installing and Configuring the WebAccess Application and WebPublisher 

Application” in “Installing GroupWise WebAccess”
 GroupWise 7: “Installing and Configuring the WebAccess Application and WebPublisher 

Application” in “Installing GroupWise WebAccess”
4 (Conditional) If the X Window System is not available, run the text-based GroupWise 

Installation program instead, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: “Installing GroupWise Components Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 8: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 7: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”

IMPORTANT: On the WebAccess Objects page, specify a new context for the WebAccess 
Application objects, so that the old objects are retained.

If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the GroupWise DVD or software distribution directory to the server 
where you have migrated the domain, then run the text-based Installation program to install the 
WebAccess Application on the Linux server.

5 (Conditional) If you want to use WebPublisher on Linux, perform the manual configuration 
described in the following section of the GroupWise Installation Guide for your version of 
GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “Configuring WebPublisher” in “Installing GroupWise WebAccess”
 GroupWise 7: “Configuring WebPublisher” in “Installing GroupWise WebAccess”

6 In ConsoleOne, review the property pages for the old WebAccess Application objects:
 GroupWise WebAccess
 Novell Speller
 LDAP Provider
 GroupWise Provider
 GroupWise Document Provider
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7  Transfer any settings that you have customized on the old WebAccess Application objects to the 
new WebAccess Application objects.

8 (Conditional) If you installed WebPublisher, review the property pages of the old GroupWise 
WebPublisher object, then transfer any settings that you have customized on the old GroupWise 
WebPublisher object to the new GroupWise WebPublisher object.

9 (Conditional) If you have customized any WebAccess or WebPublisher template files, copy the 
customized template files from the old Web server to the following directories on the Linux Web 
server:

/var/opt/novell/gw/WEB-INF/classes/com/novell/webaccess/templates
/var/opt/novell/gw/WEB-INF/classes/com/novell/webpublisher/templates

10 Stop and then start Apache and Tomcat, as described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: N/A.
 GroupWise 8: “Restarting the Web Server” in “Installing GroupWise WebAccess”
 GroupWise 7: “Restarting the Web Server” in “Installing GroupWise WebAccess”

11 Verify that the new WebAccess Application is communicating successfully with the existing 
WebAccess Agent by accessing your GroupWise mailbox through the WebAccess client:

http://new_web_server_address/gw/webacc

12 To keep users’ existing browser bookmarks from being broken, redirect the old WebAccess and 
WebPublisher URLs to the new WebAccess and WebPublisher URLs: 
12a (Conditional) If your old Web server was Apache on NetWare:

12a1  Change to the conf subdirectory of the Apache root directory (for example, 
\apache2\conf).

12a2  Edit the Apache configuration file for GroupWise.
On NetWare 6, the Apache configuration file is gwapache.conf. On NetWare 6.5, the 
Apache configuration file is gwapache2.conf.

12a3  Add the following line:

redirect permanent /servlet/webacc 
                        http://web_server_address/gw/webacc

12a4  If you use WebPublisher, add the following additional line:

redirect permanent /servlet/webpub 
                        http://web_server_address/gw/webpub

12a5  Save the file, then exit the editor.
12a6  Restart Apache to put the redirections into effect.

12b (Conditional) If your old Web server was Internet Information Server (IIS) on Windows:
12b1  Change to the netpub\wwwroot subdirectory of the IIS root directory (for example, 

c:\inetpub\wwwroot).
12b2  Create a subdirectory named servlet.
12b3  Under the servlet subdirectory, create a subdirectory named webacc.
12b4  If you use WebPublisher, create a second subdirectory named webpub.
12b5  In IIS Manager, expand the tree in the left pane to display Default Web Site under Web 

Sites.
Under Default Web Sites, you should see the servlet subdirectory you created in 
Step 12b2
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12b6  Expand the servlet subdirectory to display the webacc subdirectory (and optionally, 
the webpub subdirectory) that you created in Step 12b3.

12b7  Right-click the webacc subdirectory, then click Properties.
12b8  Click Directory, select A Redirection to a URL, then type /gw/webacc in the associated 

field.
12b9  Select A Permanent Redirection for This Resource, then click OK to save your changes.

12b10  If you use WebPublisher, repeat Step 12b7 through Step 12b9, using webpub in place of 
webacc.

12b11  Restart the IIS Web server to put the redirections into effect.
13 Notify users of the new WebAccess and WebPublisher URLs so that users can update their 

browser bookmarks if they want to.
14 (Optional) Uninstall the old WebAccess Application software to reclaim disk space on the 

NetWare or Windows server. 
See Chapter 9, “What’s Next,” on page 67.
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15 15Manually Migrating Monitor to Linux

As with WebAccess, you can migrate just the Monitor Agent, just the Monitor Application, or both 
from NetWare or Windows to Linux. The process includes accessing a domain (either local or 
remote), installing the Monitor software on Linux, copying the Monitor Agent configuration file 
(monitor.xml) from NetWare or Windows to Linux, and modifying the configuration file. For 
convenience, you can keep the Monitor Application on the same Web server as the WebAccess 
Application.

 Section 15.1, “Manually Migrating the Monitor Agent to Linux,” on page 101
 Section 15.2, “Manually Migrating the Monitor Application to Linux,” on page 103

NOTE: Monitor migration is not provided in the Server Migration Utility. It must be done manually.

15.1 Manually Migrating the Monitor Agent to Linux
1 On the Linux server, become root in a terminal window.
2 Make sure that the Web server where the Monitor Application is installed is up and running.
3 Provide access to a domain directory and its associated domain database (wpdomain.db).

If the domain directory is located on another Linux server, use your mount command of choice. 
If the domain directory is located on a NetWare or Windows server, see Section 10.2.1, “Making 
a NetWare or Windows Server Visible from Linux,” on page 72 for suggested mount commands.

4 (Conditional) If your Linux environment includes the X Window System, run the GUI 
GroupWise Installation program to install the Linux WebAccess Agent software, as described in 
the following section of the GroupWise Installation Guide for your version of GroupWise:
 GroupWise 2012: “Installing and Configuring the Linux Monitor Agent” in “Installing 

GroupWise Monitor”
 GroupWise 8: “Installing the Linux Monitor Agent” in “Installing GroupWise Monitor”
 GroupWise 7: “Installing the Linux Monitor Agent” in “Installing GroupWise Monitor”

5 (Conditional) If the X Window System is not available, run the text-based GroupWise 
Installation program instead, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: “Installing GroupWise Components Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 8: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 7: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
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If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the GroupWise DVD or software distribution directory to the server 
where you have migrated the domain, then run the text-based Installation program to install the 
Monitor Agent on the Linux server.

6 Configure the Linux Monitor Agent, as described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Installing and Configuring the Linux Monitor Agent” in “Installing 

GroupWise Monitor”
 GroupWise 8: “Configuring the Linux Monitor Agent” in “Installing GroupWise Monitor”
 GroupWise 7: “Configuring the Linux Monitor Agent” in “Installing GroupWise Monitor”

7 Restart the Web server, as described in the following section of the GroupWise Installation Guide 
for your version of GroupWise:
 GroupWise 2012: “Installing and Configuring the Linux Monitor Agent” in “Installing 

GroupWise Monitor”
 GroupWise 8: “Restarting the Web Server” in “Installing GroupWise Monitor”
 GroupWise 7: “Restarting the Web Server” in “Installing GroupWise Monitor”

8 Start the Linux Monitor Agent, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: “Starting the Linux Monitor Agent as a Daemon” in “Installing 

GroupWise Monitor”
 GroupWise 8: “Starting the Linux Monitor Agent as a Daemon” in “Installing GroupWise 

Monitor”
 GroupWise 7: “Starting the Linux Monitor Agent as a Daemon” in “Installing GroupWise 

Monitor”
9 Make sure that the Linux Monitor Agent can communicate with the Monitor Application by 

viewing the following URL:

http://web_server_network_address/gwmon/gwmonitor

If the Monitor Web console does not appear, review the preceding steps to verify that all steps 
have been followed. For additional assistance, see the following section of GroupWise 
Troubleshooting 2: Solutions to Common Problems for your version of GroupWise:
 GroupWise 2012: “Monitor Agent Problems” in “Strategies for Agent Problems”
 GroupWise 8: “Monitor Agent Problems” in “Strategies for Agent Problems”
 GroupWise 7: “Monitor Agent Problems” in “Strategies for Agent Problems”

10 Stop the Linux Monitor Agent, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: “Stopping the Linux GroupWise Agents” in “Installing GroupWise 

Agents”
 GroupWise 8: “Stopping the Linux GroupWise Agents” in “Installing GroupWise Agents”
 GroupWise 7: “Stopping the Linux GroupWise Agents” in “Installing GroupWise Agents”

11 Copy the Monitor Agent configuration file (monitor.xml) from its Windows location:
 GroupWise 2012: c:\Program Files\Novell\GroupWise Server\ Monitor
 GroupWise 8: c:\Program Files\Novell\GroupWise Server\Monitor
 GroupWise 7: c:\gwmon

to its location on Linux:
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/opt/novell/groupwise/agents/share

12 Edit the monitor.xml file for its new location:
12a Change the HOME_PATH setting to the full path to the domain directory that you made 

accessible in Step 3.
12b Change the LOG_PATH setting to the typical location for Monitor Agent log files on Linux (/

var/log/novell/groupwise/gwmon).
12c Change the LOG_ACCOUNTING_PATH setting to the typical location for Monitor Agent 

accounting file on Linux (/var/log/novell/groupwise/gwmon/acct).
12d Change the LOG_EDITOR setting to '' '' (an empty setting).

13 Start the Linux Monitor Agent with its new configuration file.
14 Make sure that the Linux Monitor Agent can still communicate with the Monitor Application by 

viewing the Monitor URL for the platform of your Web server:

http://web_server_network_address/gwmon/gwmonitor

15 Stop the old Windows Monitor Agent.
16 (Optional) Uninstall the old Monitor Agent software to reclaim disk space on the NetWare or 

Windows server. 
See Chapter 9, “What’s Next,” on page 67.

15.2 Manually Migrating the Monitor Application to Linux
1 On the Linux server, become root in a terminal window.
2 Make sure that the Linux server already has Apache and Tomcat configured and running 

successfully and that you know the full path to the Apache and Tomcat root directories.
3 (Conditional) If your Linux environment includes the X Window System, run the GUI 

GroupWise Installation program to install and configure the Linux Monitor Application, as 
described in the following section of the GroupWise Installation Guide for your version of 
GroupWise:
 GroupWise 2012: “Installing and Configuring the Linux Monitor Application” in “Installing 

GroupWise Monitor”
 GroupWise 8: “Installing and Configuring the Monitor Application” in “Installing 

GroupWise Monitor”
 GroupWise 7: “Installing and Configuring the Monitor Application” in “Installing 

GroupWise Monitor”
4 (Conditional) If the X Window System is not available, run the text-based GroupWise 

Installation program instead, as described in the following section of the GroupWise Installation 
Guide for your version of GroupWise:
 GroupWise 2012: “Installing GroupWise Components Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 8: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
 GroupWise 7: “Installing the GroupWise Agents Using the Text-Based Installation 

Program” in “Installing GroupWise Agents”
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If you need to perform the installation from a remote location, you can use ssh to access the 
remote Linux server. Copy the GroupWise DVD or software distribution directory to the server 
where you have migrated the domain, then run the text-based Installation program to install the 
Monitor Application on the Linux server.

5 Stop and then start Apache and Tomcat, as described in the following section of the GroupWise 
Installation Guide for your version of GroupWise:
 GroupWise 2012: “Installing and Configuring the Linux Monitor Application” in “Installing 

GroupWise Monitor”
 GroupWise 8: “Restarting the Web Server” in “Installing GroupWise Monitor”
 GroupWise 7: “Restarting the Web Server” in “Installing GroupWise Monitor”

6 Verify that the new Monitor Application is communicating successfully with the existing 
Monitor Agent by viewing the Monitor URL for the platform of your Web server:

http://web_server_network_address/gwmon/gwmonitor

7 (Optional) Uninstall the old Monitor Application software to reclaim disk space on the NetWare 
or Windows server. 
See Chapter 9, “What’s Next,” on page 67.
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III IIIIn-Place Database Migration

The GroupWise Server Migration Utility helps you migrate your GroupWise system from NetWare 
or Windows to Linux by copying domains and post offices from one server to another. If your 
domains and post offices are located on a SAN, you do not need to copy the domains and post office 
from one location to another. You can convert the domain and post office directory structures to the 
format used on Linux, so that the same physical location can be mounted for use on a different 
operating system.

The directory structure format used on NetWare and Windows uses mixed-case file names and 
directory names. Because Linux is a case-sensitive operating system, directory structures originally 
created on Linux use only lowercase file names and directory names. Therefore, directory structures 
originally created on NetWare or Windows need to be converted to lowercase file names and 
directory names in order to be usable by the GroupWise Linux agents. DBCopy can perform this 
conversion.

 Chapter 16, “Performing an In-Place Database Migration,” on page 107
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16 16Performing an In-Place Database 
Migration

1 Install DBCopy on the Linux server where you want to mount the domain or post office.
For instructions, see the following section in the GroupWise Administration Guide for your version 
of GroupWise:
 GroupWise 2012: “Using DBCopy on Linux” in “Databases”
 GroupWise 8: “Using DBCopy on Linux” in “Databases”
 GroupWise 7: “Using DBCopy on Linux” in “Databases”

2 (Conditional) For an NSS volume on an OES Linux server, set the name space on the volume to 
Unix.
The default OES Linux name space setting is Long, which is case insensitive. The Unix name 
space setting is case sensitive, which allows all file names and directory names in the domain or 
post office directory structure to be converted to lower case. For instructions, see “Configuring 
the Name Space for an NSS Volume” in the NSS File System Administration Guide for Linux for 
your version of OES Linux. (http://www.novell.com/documentation/oes.html)

3 Mount the domain or post office directory to the Linux server.
4 Change to the following directory:

/opt/novell/groupwise/agents/bin

5 Use the following command to convert the domain or post office directory structure to 
lowercase:

./dbcopy -l domain_or_post_office_directory

6 Install and start the GroupWise Linux agents on the Linux server where the domain or post 
office is mounted, as described in the following section of the GroupWise Installation Guide for 
your version of GroupWise:
 GroupWise 2012: “Installing the Linux GroupWise Agents” in “Installing GroupWise 

Agents”
 GroupWise 8: “Installing the GroupWise Agents on Linux” in “Installing GroupWise 

Agents”
 GroupWise 7: “Installing the GroupWise Agents on Linux” in “Installing GroupWise 

Agents”
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IV IVAppendixes

 Appendix A, “Troubleshooting Post-Migration Problems,” on page 111
 Appendix B, “Documentation Updates,” on page 115
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A ATroubleshooting Post-Migration 
Problems

 “Messages are not flowing between the migrated POA and the MTA for the domain” on 
page 111

 “The POA cannot start” on page 111
 “The POA cannot start because of incorrect permissions” on page 112
 “The POA cannot start because of a C06B error” on page 112
 “The POA starts with SSL errors” on page 113
 “The POA starts with TCP/IP errors” on page 113

Messages are not flowing between the migrated POA and the MTA for the domain

Problem: The migrated POA and the MTA for the domain are not able to communicate 
with each other.

Possible Cause: The source POA was stopped before the configuration changes described in 
Section 7.6, “Modifying Configuration Information in ConsoleOne,” on page 46 
replicated to the POA.

Action: Manually configure the MTP link between the source POA and the MTA for the 
domain.

1 Display the POA Web console.

http://source_server_address:port_number

For more information about the POA Web console, see “Using the POA 
Web Console” in “Post Office Agent” in the GroupWise 7 Administration 
Guide.

2 Click MTP Status.
The status in the Receive column shows Closed.

3 Click the Closed link, 
4 In the Address field, specify the new IP address of the POA, then select Start 

MTP Receive.
5 Click Submit to execute the actions.

The POA cannot start

Problem: The POA tries to start, but exits.

Possible Cause: The POA log file path information has not yet been reconfigured, as described in 
Section 7.6.2, “Reconfiguring the Migrated POA,” on page 47.
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Action: Properly configure the log file path.

1 Start the POA with the /noconfig switch so that the POA ignores the 
troublesome configuration settings and starts successfully.

2 Because of the /noconfig switch, manually configure the link between the 
POA and the MTA for the domain as described in “Messages are not 
flowing between the migrated POA and the MTA for the domain” on 
page 111

3 Follow the instructions in Section 7.6.2, “Reconfiguring the Migrated POA,” 
on page 47 to configure the log file path correctly.

4 Allow time for the configuration information to replicate from ConsoleOne 
to the post office database (wphost.db) so that the POA has the correct 
configuration settings.

5 Start the POA again.
It should start successfully this time.

The POA cannot start because of incorrect permissions

Problem: The POA cannot start and displays the following message:

Error: Running the agent with conflicting effective users

Possible Cause: You are trying to set the POA up to run as a non-root user, as described in 
“Running the Linux GroupWise Agents as a Non-root User” in “Installing 
GroupWise Agents” in the GroupWise 7 Installation Guide, but you have already 
run the POA as root.

Action: Remove the file that is preventing the POA from running as a non-root user.

1 On the Linux server, change to the post office directory.
2 Delete the uid.run file.
3 Start the POA again.

It should start successfully this time.

The POA cannot start because of a C06B error

Problem: The POA tries to start, but displays a C06B error and exits.

Possible Cause: The post office owns a library that has one or more remote document storage 
areas and they have not been configured with Linux paths, as described in 
“Reconfiguring Remote Document Storage Areas” on page 48.

Action: Properly configure the remote document storage area.

1 Start the POA with the /noconfig switch so that the POA ignores the 
troublesome configuration settings and starts successfully.

2 Because of the /noconfig switch, manually configure the link between the 
POA and the MTA for the domain as described in “Messages are not 
flowing between the migrated POA and the MTA for the domain” on 
page 111

3 Follow the instructions in “Reconfiguring Remote Document Storage 
Areas” on page 48 to configure the remote document storage areas 
correctly.
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4 Allow time for the configuration information to replicate from ConsoleOne 
to the post office database (wphost.db) so that the POA has the correct 
configuration settings.

5 Start the POA again.
It should start successfully this time.

The POA starts with SSL errors

Problem: The POA starts, but messages indicate that SSL is not available.

Possible Cause: The POA SSL certificate and key file paths have not yet been reconfigured, as 
described inSection 4.6, “Handling SSL Certificate and Key Files,” on page 28 
and Section 7.3, “Transferring SSL Certificate and Key Files,” on page 44.

Action: Properly configure the SSL certificate and key files for the POA

1 In ConsoleOne, browse to and right-click the POA object, then click 
Properties.

2 Click GroupWise > SSL Settings.
3 Remove the path information from the Certificate File and Key File fields.

The information pertains to the source NetWare or Windows server, not the 
Linux server, and is therefore not needed.
The Server Migration Utility places certificate files and key files in their 
default location on Linux (/opt/novell/groupwise/agents/bin).

4 Click OK to save the settings.
5 Allow time for the configuration information to replicate from ConsoleOne 

to the post office database (wphost.db).
When the POA has the correct configuration settings, SSL is enabled as 
usual.

The POA starts with TCP/IP errors

Problem: The POA starts with the error:

TCP/IP services on your system may not be configured or installed

Possible Cause: The /ip startup switch in the POA startup file (/opt/novell/agents/share/
post_office.poa) still has the IP address of the source NetWare or Windows 
server. 

This would happen only if you manually copied the startup file to the Linux 
server, because the Server Migration Utility comments out the /ip switch in order 
to avoid this problem.

Action: Edit the POA startup file and update the IP address to match the Linux server.
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B BDocumentation Updates

This section lists updates to the GroupWise Server Migration Utility Installation and Migration Guide that 
have been made since the initial release of the Server Migration Utility. The information helps you to 
keep current on documentation updates and, in some cases, software updates (such as a Support 
Pack release).

The information is grouped according to the date when the GroupWise Server Migration Utility 
Installation and Migration Guide was republished. Within each dated section, the updates are listed by 
the names of the main table of contents sections.

The GroupWise Server Migration Utility Installation and Migration Guide has been updated on the 
following dates:

 Section B.1, “January 24, 20112,” on page 115
 Section B.2, “August 24, 2010,” on page 115
 Section B.3, “May 4, 2009,” on page 116
 Section B.4, “December 19, 2008,” on page 116

B.1 January 24, 20112

B.2 August 24, 2010

Location Change

Entire guide Updated for use with GroupWise 2012.

Location Change

Chapter 1, “What Is the 
Server Migration Utility?,” on 
page 11

Added a link to instructions for performing an “in place” migration, where 
the Server Migration Utility is not needed.

Section 2.2, “Server 
Operating System 
Requirements,” on page 17

Added Windows Server 2008 R2.

Section 2.2, “Server 
Operating System 
Requirements,” on page 17

Added SUSE Linux Enterprise Server 11.
Documentation Updates 115



B.3 May 4, 2009

B.4 December 19, 2008

Section 2.3, “Windows 
Workstation Requirements,” 
on page 18

Added Windows Vista/7 and Windows Server 2008 R2.

Section 11.2, “Performing 
the Post Office Migration,” 
on page 76

Mentioned that DBCopy can be run multiple times with the -f switch before 
it is run with the -s switch.

Section 11.4, “Finalizing the 
Post Office Migration,” on 
page 81

Removed the -i switch in Step 2. It is not necessary due to the -s switch.

Location Change

Location Change

GroupWise Server Migration 
Utility Installation and 
Migration Guide

Updated the entire Server Migration Utility Guide for version 1.1 of the 
Server Migration Utility.

Section 4.4.3, “Remote 
Document Storage Areas for 
a Post Office,” on page 27

Added recommendations when dealing with remote document storage.

Section 7.2, “Verifying 
Remote Document Storage 
Areas,” on page 43

Moved instruction for migrating remote document storage areas to a more 
appropriate place in the guide. Updated steps to not include moving 
remote document storage at this point in the migration.

Section 7.6, “Modifying 
Configuration Information in 
ConsoleOne,” on page 46

Changed the order of the steps to match the new order of the server 
migration utility.

Added the section Section 7.6.3, “Handling Remote Document Storage 
Areas,” on page 47.

Added the section Section 7.6.4, “Reconfiguring SSL Settings,” on 
page 48.

Section 8.5, “Modifying 
Configuration Information in 
ConsoleOne,” on page 58

Changed the order of the steps to match the new order of the server 
migration utility.

Added the section Section 8.5.3, “Reconfiguring SSL Settings,” on 
page 59.

Location Change

GroupWise Server Migration 
Utility Installation and 
Migration Guide

Moved the Migration section of the GroupWise 7 Installation Guide into 
this guide.

Updated the entire Server Migration Utility Guide for GroupWise 8.
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Section 2.1, “GroupWise 
Version Requirements,” on 
page 17

Added support for GroupWise 8; removed support for GroupWise 6.5.

Section 4.4.1, “Post Offices 
and Domains,” on page 23

Recommended that domain and post office directory names should be all 
lowercase before running the Server Migration Utility.

Section 11.3, “Reconfiguring 
the Post Office in 
ConsoleOne,” on page 80

Changed the order of the steps so that reconfiguring the post office 
location comes after other reconfiguration tasks, which allows the other 
reconfiguration tasks to complete successfully before the post office 
closes.

Section 11.4, “Finalizing the 
Post Office Migration,” on 
page 81

Removed the step for running GWCheck manually, because DBCopy now 
does it automatically.

Added the step of enabling users after the POA is running in its new 
location.

Location Change
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